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Chances are that you already know this part but ...

Installing from CD ROM
Insert the CD ROM in your CD Drive. If the installation program does not auto-start, then go to
the CD ROM drive and dbl-click on the only executable file in the root directory of the CD. If
you are presented with a choice of products, select the DIGIVIEW software and follow the
prompts to complete the installation. All of the defaults offered are acceptable but you may
over-ride any of them you want.

Installing from a WEB Download
If you downloaded the software from our web site, double-click on the file you downloaded to
launch the self-extracting install program. Follow the prompts to install the software. All of the
defaults offered are acceptable but you may over-ride any of them you want.
(see also: Installing USB Drivers

1.1

2

)

Installing the USB Drivers
We have 2 versions of the installer; the Current Release and a Legacy Release. The CURRENT
RELEASE supports 32 and 64 bit versions of XP, Vista and Win7. The Legacy release supports
Win98se, Win98Me and Win2K. It is available from our web site but is no longer updated or
supported.
Our DigiView software and drivers are Authenticode signed.
If Windows reports that the publisher is unknown or that the software is not signed, then
the files are corrupt, infected or otherwise modified. Cancel the installation, delete the file
and download an authentic copy from our web site: http://www.tech-tools.com. The
Authenticode signature is timestamped to ensure the signature remains valid even if our Certificate
eventually expires. In other words, it will not 'time-out.' You will be able to re-install the software
and drivers, even if we go out of business or fail to renew our certificate.
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Run the application installer BEFORE plugging in the hardware. It installs the application
software and pre-installs the drivers. You can accept the defaults or modify to suite your needs.
Depending on your Windows version and system settings, Windows might ask your permission to
install the application and again to install the drivers.
When the installation is complete, plug the DigiView into a high-speed USB port (preferably to a
port directly connected to the motherboard at the rear of the computer or a port anywhere on the
computer case that utilizes a high quality cable internally). Current versions of Windows will see
the hardware and will find the pre-installed drivers automatically. Other versions will present a Add
New Hardware Wizard.
Answer as follows for the smoothest installation:
Win 7:
· No action needed.
Vista:
· No action needed.
XP:
· Search Windows Update? : "No,not at this time" (just saves time)
· "Install the software automatically" (the default)
Win Me:
· "Specify the location of the driver"
· Select "Specify a location:" Then enter the path to the TechTools\drivers directory in the edit
box. If you used the defaults during installation, this would be: "C:\Program
Files\TechTools\DigiView\drivers"
Win 98se:
· "Search for the best driver..."
· Select "Specify a location:" Then enter the path to the TechTools\drivers directory in the edit
box. If you used the defaults during installation, this would be: "C:\Program
Files\TechTools\DigiView\drivers"
If this is the first driver on your system to use the latest driver framework, Windows will take
additional steps to update the system. Newer frameworks coexists with any older frameworks,
ensuring that existing drivers continue to operate as before. Unfortunately, this takes Windows
several minutes and requires a system reboot to complete. Note that this update occurs (if
required) when you plug in the DigiView – not during our application install.
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Configuration
The DigiView software is designed to make configuration an easy task and less time consuming
than most PC based analyzer systems. The easier it is configure and understand your Capture
and Analysis tool, the easier it will be to achieve successful results.
Configuration options can be accessed by using the CONFIG menu.
After the hardware is connected to the PC, the first step of configuration is to attach the physical
channels to the circuit and create a Signal definition that uses those channels.
The first topic in this section, after some brief USB information, covers the physical channel
connections and cable color scheme. The next section provides detailed information on defining
trigger conditions and associating a signal type with the physical channels. The remaining sections
deal with user preferences.

·
·
·
·
·
·
·

2.1

USB Connection 5
Connecting Data Lines 6
Defining Signals and Triggers
Analyzer Options 49
Acquisition Options 53
Color Themes 55
Environment Options 57

7

USB Connection
Power:
· DV3100, DV3109, DV3200, DV3209, DV3409:
Plug DigiView into a POWERED HUB (one with its own power supply) or directly into a USB port
on your PC. You can not use a bus-powered hub; it does not have enough power to operate
DigiView.
· DV3400:
Powered by an external power supply, so USB power is of no concern.

Speed:
· DV3100, DV3109, DV3200, DV3209, DV3400, DV3409:
You will experience better performance on a 2.0 port, but a 1.1 port is sufficient.

Connection Quality:
Preferably, use a high-speed USB port located directly on the motherboard at the rear of the
computer or a port anywhere on the computer case that utilizes a high quality cable internally. If
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you use a different USB cable than the one provided with the unit, it should match the full rated
speed of the USB connection to prevent communication errors or loss of data.

2.2

Connecting the Data Lines
The DigiView data cable has 18 data lines and 2 grounds (or 9 data lines and 1 ground on some
models). These are partitioned into 2 identical groups. Each group has a ground and 9 data
signals. The leads are color-coded. Black is ground, brown is the first data signal, red is the
second data signal and so on in standard resistor color-code order. Additional groups of signals
follow the same pattern.
The images below show the physical layout of the cable, data line definitions and color codes on
various models. This figure is available by clicking the PINOUT button in the "Edit Triggers &
Signals 7 " window (selected from the CONFIG menu). This opens a non-modal window so you
can leave it open while you work if desired.
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The data cable is made of high quality, extremely flexible wire and high quality connectors. It is
expensive, so please remember to pull on the connectors; not the wires.
The connectors are designed to mate to .025 square posts and can be side-stacked on 100mil
centers, making them ideal for direct connection to standard square post connectors. Additionally,
they mate firmly with the included micro-grabber hooks for connecting to IC leads.
DigiView Models DV3100, DV3109, DV3200, DV3209 and DV3409 are designed for signals in the
-20 to 20V range and Model DV3400 is designed for signals in the -50 to 50V range. Standard
overshoots and undershoots common to digital systems will not harm it. The data lines have
extra static protection circuits, current limits and impulse suppression. However,
mishandling could still damage them. Simply treat them like you (should) treat your valuable
one-of-a-kind target and DigiView will give you years of service.

2.3

Defining Signals and Triggers
The hardware will ignore any data lines that are not defined as part of a waveform or part of a
trigger. This prevents unused signals from eating up the sample buffer space, even if they are
connected to active signals. Waveforms that are defined but disabled will not be displayed, but
may still be captured if the signal's definition includes a channel that is in use by another signal
definition.
· Signals
· Triggers

© 2014 TechTools
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Signals
Current DigiView hardware has either 18 or 36 physical channels. However, we like to think in
terms of symbolic names representing individual signals (clock,ALE) or groups of signals
(DataBus, Address) rather than channel numbers(0,1,2..). We start by defining SIGNALS in
terms of CHANNELS. This is the only place we deal directly with physical channels. The
remainder of the software deals in terms of signal names rather than channel numbers. When we
define signals, we are mapping a signal NAME to one or more physical channels. This also
makes it possible to share the same physical channel with multiple signal definitions (see: Signal
Editors 10 ).
Adding Signals to the Project
The create a Signal, select "Config->Signals..." from the main menu, which will open the
"Project Settings" window to the Signal Definition tab.

Double-Click on one of the "Define New Signal" selections to create a new signal or Highlight
your choice and select "Add". A new signal of the chosen type will be created and it's property
editor will appear. You can rename the signal, change the physical channels to use for this
signal definition and set all associated options from the signal's editor. (For details on signal
options, see the section: Signal Editors 10 )
Summary of the Project's Signals
The main purpose of the lower section of the config screen is to provide an overview of all
current signal definitions and their related channels. You can also Edit or Delete signals from
this section, determine each signal's type, its basic colors and its enabled status.The
configuration section is arranged in a grid with columns representing the physical channels
and one row per defined signal. Notice that the same channel can be assigned to multiple
signal definitions. In the image below, channel 0 has been assigned to the Bus, STATE,
Analog and STATE[1] signal definitions.

© 2014 TechTools

Configuration

9

Channel 0 is in the farthest right column and channel 17 (or 35) is in the farthest left column
(as marked in the header.) Light blue lines appear every 4th channel (or nibble).
In addition to the color references at the top of the window, you can click on the 'Cable
Connector Pinout' button at the bottom of the window to see a physical layout of the attached
analyzer's channel connector, with color codes.
Note that it is important to enable only channels that are actually being connected to your
circuit. The remaining, unconnected channels will be floating and will most likely pick up noise
or power line hum. If enabled, these transitions will get stored, wasting storage space. It is
also important to connect the black ground wires to your target's ground so that the analyzer
and the target have a common ground reference.
Changing the Signal order When adding a large number of signal definitions, you may want to change some of their
positions to organize or group related signals. To change the display order, grab the small
handle in the left margin with your mouse and drag the definition to a new position.
Signal Name The name of this signal definition. This value can be changed by editing the signal's
properties. (see: Signal Editors 10 )
Signal Colors and Type ,
,
, etc.
You can see the color of a signal and determine the type by this graphical indicator
(displayed to the right of the name assigned to the signal). Each signal type will display a
unique graphic with representative colors.
Delete Signal You can delete a signal definition by clicking on the 'X'.
Edit Signal Properties You can change the properties of a signal definition by clicking this button. (see: Signal
Editors 10 )

© 2014 TechTools
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Enabled Status Indicates the enabled state of the signal. When the lightbulb is ON, the signal is enabled.
Click this button to toggle the "enabled" status of the signal. This value can also be changed
by editing the signal's properties. (see: Signal Editors 10 )
Associated Channels All channels associated with this signal definition will be indicated in this display as a blue
"dot". Channel 0 is in the farthest right column and channel 17 (or 35) is in the farthest left
column (as marked in the header.) Light blue lines appear every 4th channel and non
associated channels appear as '-' as a reference. Also, colored squares at the top show
each channel's wire color. Notice that there are only 9 colors so the color sequence repeats
(channels 0 and 9 are both brown - the color Black is used for ground connections).

2.3.1.1

Signal Editors
DigiView provides several "Signal" type definitions which allow unique methods of interpreting and
displaying the raw data captured on the logic channels. Each Signal type has a unique editor with
relevant options for its type. From the editor you will also assign some of the physical logic
channels to be used for this new signal definition. (see: Signals 8 , Connecting Data Lines 6 )
You may choose to repeat the use of some channels in multiple Signal definitions in order to
interpret the data differently and gain a perspective that is relative to your current point of interest.
This can be done easily by creating a new Signal using the definition with the properties you
require. Using the same channels in multiple definitions will not have any effect on the actual
capture, but can greatly increase your ability to analyze the data and present visual representation
to others.
NOTE: For your convenience, the signal editors display a darker background on channels that are
already assigned to other signals. However, the same channel can be assigned to as many signal
definitions as you need. For instance, if you want to capture the Read and Write cycles of an SPI
bus using separate signal definitions (instead of the combined read/write of the SPI signal type),
you can create 2 Synchronous Serial signals and assign the same channel as the Clock for each
definition.
The currently available Signal Types are listed below. Details of each type's properties are
described in the following sections.
Analog 16
Multiple channels combined to a single analog view.
Asynchronous 14
Serial UART analysis, pre-selected and custom baud rates, channel inversion option, from 4
to 8 bit selectable, parity option, Framing options and Glitch filter.
Boolean 11
Single channel viewing.
Bus 12
Multi-channel viewing.
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I2C 18
Complete I2C protocol analysis. 7bit/10bit addressing, High Speed Mode Master Codes,
General Call support, Glitch filter.
SPI 25
Master/Slave data from two Synchronous Serial data channels using the SPI protocol.
State 21
Filters multi-channel data by state of a single channel, selectable CLK/DATA inversion,
selectable transition state of Rising/Falling/Both, Framing and timeout options, additional
Select and Sync channel for filtering.
Synchronous 23
From 1 to 32 bit protocols, suitable for SPI analysis, selectable CLK/DATA inversion,
selectable Rising/Falling/Both clock edges, LSB/MSB selection, additional Select, Frame
Sync and Field Sync channels for filtering and synchronizing.

2.3.1.1.1 Boolean

The Boolean Signal is the most common method of viewing captured data. Boolean Signals
provide viewing of the logic level of a single channel at any given point in time.

Signal Name - Change the text displayed here to help you identify this signal definition. If the
name has already been used, it will automatically be appended with a numerical value in
brackets (i.e. [2]). The name displayed here will be used in the Waveform Views, searches,
tables, lists (if applicable), exports and all menu references.
Color Selection & Examples - If this signal definition has multiple Wave Form viewing
modes, an example of each mode is displayed in the current color scheme, followed by a
listing of any items that allow custom colors (i.e. Signal Color, Signal Background). Click on
an item in the list to select a new color.
Disable Signal - Select (check) this item to completely disable the Signal Definition. It is
recommended to disable any signals that use channels that are not connected to a physical
device. When a capture takes place ("Run"), any channels that are assigned to disabled
signals will be ignored instead of using valuable capture space.
© 2014 TechTools

12

DigiView User's Guide

Invert Signal - Check this item to have the value of the captured channels "inverted" before
processing or displaying data for this signal definition. This setting will not effect any other
signal definitions that may use the same channels.
Channels - This is where you will associate a signal definition with the physical channels or
connections to the outside world. Each signal definition type will have one or more channel
selection groups and will allow one or more channels to be selected for each group. Each
channel selection group will be identified on its left if more than one group is available for the
signal type.
To select a channel, click on the " - " below the proper color (and channel number) that
corresponds to the physical connection of the DigiView Cable (see: Connecting the Data
Lines 6 ). Channels that are selected for this signal will replace the " - " with a blue "dot" as
shown above. Channels that are already defined in other signal definitions will have a darker
color around the selection area for the channel (as channels 0, 1, 2, 4 and 5 do in the
graphic above).
Reset Colors - This button will reset the colors for this signal so that they will match the
currently selected color theme (see: Color Themes 55 ).

2.3.1.1.2 Bus

The Bus Signal is the second most common method of viewing captured data. Bus Signals
provide viewing of multiple channels as a single value at any given point in time.

Signal Name - Change the text displayed here to help you identify this signal definition. If the
name has already been used, it will automatically be appended with a numerical value in
brackets (i.e. [2]). The name displayed here will be used in the Waveform Views, searches,
tables, lists (if applicable), exports and all menu references.
Color Selection & Examples - If this signal definition has multiple Wave Form viewing
modes, an example of each mode is displayed in the current color scheme, followed by a
listing of any items that allow custom colors (i.e. Signal Color, Signal Background). Click on
an item in the list to select a new color.
Disable Signal - Check this item to completely disable the Signal Definition. It is
© 2014 TechTools
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recommended to disable any signals that use channels that are not connected to a physical
device. When a capture takes place ("Run"), any channels that are assigned to disabled
signals will be ignored instead of using valuable capture space.
Invert Signal
This item is de-selected (unchecked) by default. Check this item to have the value of the
captured channels "inverted" before processing or displaying for this signal definition. This
setting will not effect any other signal definitions that may use the same channels.
Channels
This is where you will associate a signal definition with the physical channels or connections
to the outside world. Each signal definition type will have one or more channel selection
groups and will allow one or more channels to be selected for each group. Each channel
selection group will be identified on its left if more than one group is available for the signal
type.
To select a channel, click on the " - " below the proper color (and channel number) that
corresponds to the physical connection of the DigiView Cable (see: Connecting the Data
Lines 6 ). Channels that are selected for this signal will replace the " - " with a blue "dot" as
shown above. Channels that are already defined in other signal definitions will have a darker
color around the selection area for the channel (as channels 0, 1, 2, 4 and 5 do in the
graphic above).
Reset Colors - This button will reset the colors for this signal so that they will match the
currently selected color theme (see: Color Themes 55 ).

© 2014 TechTools
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2.3.1.1.3 Asynchronous

Use the Asynchronous Signal type to see the capture from a single channel decoded and
displayed as serial characters or frames of characters with a specific bit count and baud rate.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists,
Exports and all menu references.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Data
Selects which physical channel to assign to the DATA bus.
Baud Rate:
Selects from a list of standard BAUD rates or 'use custom'.
Custom Baud (bits/sec):
The BAUD rate to use if BAUD RATE is set to 'use custom'.
Data Bits
Selects the number of data bits in a character.
Parity/9bit Address flag
Selects from odd,even,one,zero,non standard parity settings.
© 2014 TechTools
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Also allows selection of 9bit addressing mode with and address
field flagged with a '1' or with a '0'.
Glitch Filter (% of bit)
Select noise filter setting of none-10% of a bit width.
Sync (skip transitions)
Specifies how many transitions to ignore at the start of the buffer.
Useful for syncing up when capture starts mid-character.
MSB First:
Specifies that bits are received in MSB first order (VERY rare).
Frame Length (Characters)
Number of characters in a frame. Set to 0 to disable.
Frame IDLE TIMEOUT (0 to ignore):
A new frame is started if no characters are seen for more than the specified time.
Set to 0 to disable. This can be useful if there are none of the other frame methods
apply, but you can see a consistent pause before each frame starts.
Frame on 9bit Address flag
Start a new frame when a 9bit address byte is detected (if parity set to 9bit mode).
Re-Frame on BREAK
Terminate and start a new frame when BREAK detected.
Show Field Idles
Specifies whether idle time between fields should be shown as a hashed field
or if the current field should just extend to the next field.
Show Frame Idles
Specifies whether idle time between frames should be shown as a single center line
or if the current frame should just extend to the start of the next frame.
Disable Signal Channels
Check this item to completely disable the Signal Definition. It is recommended to disable any
signals that use channels that are not connected to a physical device. When a capture takes
place ("Run"), any channels that are assigned to disabled signals will be ignored instead of
using valuable capture space.
Channel Selection
This is where you will associate a signal definition with the physical channels or connections
to the outside world. Each signal definition type will have one or more channel selection
groups and will allow one or more channels to be selected for each group. Each channel
selection group will be identified on its left if more than one group is available for the signal
type.
To select a channel, click on the " - " below the proper color (and channel number) that
corresponds to the physical connection of the DigiView Cable (see: Connecting the Data
Lines 6 ). Channels that are selected for this signal will replace the " - " with a blue "dot" as
shown above. Channels that are already defined in other signal definitions will have a darker
color around the selection area for the channel (as channels 0, 1, 2 and 5 do in the graphic
above).
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Reset Colors - This button will reset the colors for this signal so that they will match the
currently selected color theme (see: Color Themes 55 ).

Display Fields
DATA
Field type used for most characters. Shows the received data
Address
Field type used for 9 bit address bytes. Shows the received data
BREAK
Field type used for break events. Prints the word BREAK
ParityError
Field type used to display parity errors. Shows ' P '
FrameError
Field type used to display character framing errors. Shows ' F '
NOTE: Multiple framing methods can be used at the same time. For example, you could use a
frame length specifier and the frames will be broken into the specified lengths. If a timeout is
specified, it will override and terminate a frame if the specified time is exceeded.

2.3.1.1.4 Analog

Use the Analog Signal type to see a group of channels shown as an analog type plot. For
example, you could look at the output of an A/D as a graph rather than numbers in a bus format.
The chosen channels do not have to be consecutive. Any "skipped" channels in this definition will
be ignored and the selected channels "packed" to form the bits of a single value. The lowest
selected channel will be the least significant bit (LSB). In the graphic below, channel 0 is the LSB
and channel 7 is the MSB.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
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already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists,
Exports and all menu references.
Disable Signal
Causes this signal to be ignored in future captures and in all current searches and displays
windows.
Invert Signal
Causes the channel to be logically inverted before being displayed.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Channel Selection
Selects which physical channels to assign to the signal. You can select two or more. They
do not have to be contiguous. The total number of selected channels will become the bus
width, regardless of which channels are selected. The highest numbered channel will be
become the MSB and the lowest numbered channel will become the LSB (bit 0).
To select a channel, click on the " - " below the proper color (and channel number) that
corresponds to the physical connection of the DigiView Cable (see: Connecting the Data
Lines 6 ). Channels that are selected for this signal will replace the " - " with a blue "dot" as
shown above. Channels that are already defined in other signal definitions will have a darker
color around the selection area for the channel.
Reset Colors - This button will reset the colors for this signal so that they will match the
currently selected color theme (see: Color Themes 55 ).
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2.3.1.1.5 I2C

Use the I2C Signal type to decode two channels using the full I2C serial protocol.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists,
Exports and all menu references.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Clock (SCL)
Selects which physical channel to assign to the CLOCK.
Data (SDA)
Selects which physical channel to assign to the DATA bus.
Glitch Filter
Selects the amount of noise filtering. Should be set to 50ns for low speed buses and
reduces for FAST buses.
Skip Bits (to sync partial frame)
Specifies how many bits to ignore at the start of the buffer. Useful for syncing up when
capture starts mid-frame.
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Decode Addr 000-0001-d as
Selects between the standard I2C decoding for this address range or decoding it as normal
7 bit devices.
Decode Addr 000-001X-d as
Selects between the standard I2C decoding for this address range or decoding it as normal
7 bit devices.
Decode Addr 111-11XX-d as
Selects between the standard I2C decoding for this address range or decoding it as normal
7 bit devices.
Decode HS Master Codes as
Selects between the standard I2C decoding for this address range or decoding it as normal
7 bit devices.
Decode 10bit Codes as
Selects between the standard I2C decoding for this address range or decoding it as normal
7 bit devices.
Truncated fields
Specified whether to show truncated/partial fields or not. 1 bit truncated fields common and
unavoidable so the options include showing only if > 1 bit.
Show ACKs
Selects whether to show ACKs in the waveforms, tables and searches NAKs are always
shown.
Show Addresses as
The I2C spec defines 7 bit addresses and a 1 bit direction (R/W) in teh first field. Sometimes
it is convenient to think of this as a single 8 bit value. This option specifies whether to show
as 2 fields (per spec.) or as a single 8 bit field.
Show IDLEs
Specifies whether idle time between fields should be shown as a hashed field or if the
current field should just extend to the next field.
Channel Selection
This is where you will associate a signal definition with the physical channels or connections
to the outside world. Each signal definition type will have one or more channel selection
groups and will allow one or more channels to be selected for each group. Each channel
selection group will be identified on its left if more than one group is available for the signal
type.
To select a channel, click on the " - " below the proper color (and channel number) that
corresponds to the physical connection of the DigiView Cable (see: Connecting the Data
Lines 6 ). Channels that are selected for this signal will replace the " - " with a blue "dot" as
shown above. Channels that are already defined in other signal definitions will have a darker
color around the selection area for the channel (as channels 1 and 2 do in the graphic
above).
Reset Colors
This button will reset the colors for this signal so that they will match the currently selected
color theme (see: Color Themes 55 ).
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Display Fields
Start
Field type used to show start and repeated start event.
Shows ' S ' for start or ' Sr ' for repeated start.
Stop
Field type used for stop events. Shows ' P '.
Addr
Field type used for normal 7bit address fields
Addr8
Field type used to show first byte as 8 bit address+direction
Data
Field type used for most characters. Shows the received byte
Ack
Field type used to show Acknoledge bit. Shows ' A '
Nak
Field type used to show Nak bits. Shows ' N '.
WRITE
Field type used to show WRITE bits. Shows ' W '.
READ
Field type used to show READ bits. Shows ' R '.
General-Call
Field type used to show first byte code is General-Call.
Shows ' Gen-Call '
Start-Byte
Field type used whenthe first byte code is START BYTE.
Shows ' START '.
HS Master
Field type used when first byte code is High Speed Master.
Shows ' HS Master: ' followd by the 3 bit master ID
CBUS
Field type used when the first byte code is CBUS.
Prints the word CBUS.
Reserved
Field type used when the first byte is a reserved address.
Prints the word 'RESERVED: ' followed by the actual data
10bitMode
Field type used when the first byte code is 10 bit Mode.
Prints ' 10bitMode: ' followed by the high 2 bits of the 10bit address.
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Truncated
Field type used when a byte is truncated (bt a stop or repeated start)
Prints ' T: ' followed by the received data.
2.3.1.1.6 State

Use the State Signal type to see the data from one or more channels only when the state of
another channel changes. This other channel will be used as a "state clock" and optionally the
Clock can be qualified by the logic state of an additional channel (Enable). This signal type can be
used to mask invalid data during bus transitional periods or the "noise" that occurs during
unqualified periods, making it easier to analyze true data.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists
(if applicable), Exports and all menu references.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Clock Channel
Selects which physical channel to assign to the CLOCK.
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Data Channels
Selects which physical channels to assign to the DATA bus.
Enable Channel
Selects which physical channel to assign to the ENABLE. The enable can be disabled if not
used.
Frame SYNC Channel
Selects which physical channel to assign to the FRAME SYNC. The FRAME SYNC can be
disabled if not used. This can be used to identify frame limits.
Clock On
Selects which edge of the clock to use to strobe in then data.
Enable Level
Selects the active level for the Enable signal.
Skip States
Specifies how many states to ignore before starting a frame. Useful for syncing up data that
has no framing signals.
States per Frame
Specifies how many states are in a frame (if fixed). Set to 0 to ignore if other framing
methods are being used.
Frame SYNC starts New Frame on:
Specifies how the Frame Sync signal is used (if enabled). Rising,Falling and Either edges
specify what starts a new frame (and terminates the previous frame). The last two options
specify that one edge starts a frame and the other edge terminates the frame. Any
startframe will automatically end the previous frame. Specifying the endframe just ends it
earlier for aesthetics.
Frame IDLE Timeout (0 to ignore):
A new frame is started if no new states are seen for more than the specified time. Set to 0
to disable. This can be useful if there are no sync lines or field counts but you can see a
consistent pause before each frame starts.
Show Field Idles
Specifies whether idle time between fields should be shown as a hashed field or if the
current field should just extend to the next field.
Show Frame Idles
Specifies whether idle time between frames should be shown as a single center line or if the
current frame should just extend to the start of the next frame.
Reset Colors
This button will reset the colors for this signal so that they will match the currently selected
color theme (see: Color Themes 55 ).
NOTE: Multiple framing methods can be used at the same time. For example, you could use a
frame length specifier and the frames will be broken into the specified lengths. If a timeout is
specified, it will override and terminate a frame if the specified time is exceeded.

© 2014 TechTools

Configuration

23

2.3.1.1.7 Synchronous

Use the Synchronous Signal type to see the data from a single channel decoded as a field of data
or framed fields of data by using another channel as the bit clock. Optionally you can use the
"Select" channel to qualify the clock.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists,
Exports and all menu references.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Clock
Selects which physical channel to assign to the CLOCK.
Data
Selects which physical channel to assign to the DATA bus.
Select:
Selects which physical channel to assign to the ENABLE.
The enable can be disabled if not used.
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Frame SYNC
Selects which physical channel to assign to the FRAME SYNC.
The FRAME SYNC can be disabled if not used. This can be used to identify frame limits.
Field SYNC
Selects which physical channel to assign to the FIELD SYNC.
The FIELD SYNC can be disabled if not used. This can be used to identify field limits.
Clock On
Selects which edge of the clock to use to strobe in data.
Select Level
Selects the active level for the Select signal.
LSB first
Selects LSB (Least significant bit) first.
Frame Length (fields)
Specifies how many fields are in a frame.
Set to 0 to disable this method of framing.
Field Length(s)
Specifies a list of comma separated field lengths (in bits).
The first number is the length of the first field, the second number is the 2nd field and so
forth. Set to 0 to disable this method of framing.
Frame SYNC starts New Frame on:
Specifies how the Frame Sync signal is used (if enabled). Rising,Falling and Either edges
specify what starts a new frame (and terminates the previous frame).The last two options
specify that one edge starts a frame and the other edge terminates the frame. Any
startframe will automatically end the previous frame. Specifying the endframe just ends it
earlier for aesthetics.
Field SYNC starts New Field on:
Specifies how the Field Sync signal is used (if enabled). Rising,Falling and Either edges
specify what starts a new frame (and terminates the previous frame) The last two options
specify that one edge starts a field and the other edge terminates it. Any startfield or start
frame will automatically end the previous field. Specifying the endfield just ends it earlier for
aesthetics.
Frame IDLE TIMEOUT (0 to ignore):
A new frame is started if no new bits are seen for more than the specified time. Set to 0 to
disable. This can be useful if there are no sync lines or field counts but you can see a
consistent pause before each frame starts.
Field IDLE TIMEOUT (0 to ignore):
A new frame is started if no new bits are seen for more than the specified time. Set to 0 to
disable. This can be useful if there are no sync lines or field counts but you can see a
consistent pause before each frame starts.
Skip Bits
Specifies how many bits to ignore at the start of the buffer. Useful for syncing up when
capture starts mid-field
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Show Field IDLEs
Specifies whether idle time between fields should be shown as a hashed field or if the
current field should just extend to the next field.
Show Frame IDLEs
Specifies whether idle time between frames should be shown as a single center line or if the
current frame should just extend to the start of the next frame.

NOTE: Multiple framing methods can be used at the same time. For example, you could use a
frame length specifier and the frames will be broken into the specified lengths. If a timeout is
specified, it will override and terminate a frame if the specified time is exceeded.
Reset Colors - This button will reset the colors for this signal so that they will match the currently
selected color theme (see: Color Themes 55 ).

2.3.1.1.8 SPI Signal Properties

Use the SPI Signal type to see the Master/Slave data from two Synchronous Serial data channels
using the SPI protocol.

Signal Name
Change the text displayed here to help you identify this signal definition. If the name has
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already been used, it will automatically be appended with a numerical value in brackets (i.e.
[2]). The name displayed here will be used in the Waveform Views, Searches, Tables, Lists
(if applicable), Exports and all menu references.
Color Selection & Examples
An example is displayed in the current color scheme, followed by a listing of any items that
allow custom colors (i.e. Signal Color, Signal Background). Click on an item in the list to
select a new color.
Clock Channel
Selects which physical channel to assign to the CLOCK.
MOSI Channel
Selects which physical channel to assign to the MOSI data.
MISO Channel
Selects which physical channel to assign to the MISO data
SS Channel
Selects which physical channel to assign to SS (slave select)
Clock MOSI On
Specifies which clock edge to use to strobe in MOSI data.
Clock MISO On
Specifies which clock edge to use to strobe in MISO data
SS active level
Specifies the active level for the SS (slave select) signal
Field Idle Timeout (0 to disable)
A new field is started if no new bits are seen for more than the specified time. Set to 0 to
disable.
Skip Bits (to sync)
Specifies how many bits to ignore at the start of the buffer. Useful for syncing up when
capture starts mid-field
Field Length (bits)
Specifies the data field length from 4 to 24 bits.
Show Field Idles
Specifies whether idle time between fields should be shown as a hashed field or if the
current field should just extend to the next field.
Show Partial(P) Fields
Specifies whether to show partial fields or not. Partial fields were terminated (by timeout or
SS) before they gathered the full bit count.
Show Frame Idles
Specifies whether idle time between frames should be shown as a single center line or if the
current frame should just extend to the start of the next frame.
Frame Length (#fields)
Specifies the number of fields to include in a frame (if fixed length).
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Set to 0 to disable.
Frame Idle Timeout (0 to disable)
A new frame is started if no new bits are seen for more than the specified time. Set to 0 to
disable. This can be useful if there are no sync lines or field counts but you can see a
consistent pause before each frame starts.
Frame on SS
Specifies that we should terminate a frame on SS disable edges and start a new frame on
SS active edges.

Display Fields
MOSI-MISO
Field type used to show normal data.
Shows the both data channels, separated by a colon: ' MOSI : MISO '
(P)MOSI-MISO
Field type used to show partial (interrupted) data fields.
Shows '(P)' followed by both data channels, separated by a colon: ' (P)MOSI : MISO '.
NOTE: Multiple framing methods can be used at the same time. For example, you could use a
frame length specifier and the frames will be broken into the specified lengths. If a timeout is
specified, it will override and terminate a frame if the specified time is exceeded.
Reset Colors - This button will reset the colors for this signal so that they will match the currently
selected color theme (see: Color Themes 55 ).

2.3.2

Triggers
You can define a TRIGGER condition. When the hardware detects this condition, it will
'TRIGGER' the logic analyzer. When the sample buffer fills (or you manually STOP it), the data is
transferred to the PC. The software on the PC then displays the data to you.
The trigger point is centered on the screen and is always TIME 0. All data prior to the trigger is
negative time and all data after the trigger is positive time. If you stop the analyzer before a
trigger condition is detected, the approximate center of the collected sample buffer is considered
the trigger and the end of the data is the point where the hardware sampling was manually
stopped.
In our DigiView Software, triggers are specified in terms of SIGNALS. After assigning
channels to signal names ( see: Signals 8 ), you can configure the trigger condition based on the
defined signals. Most engineers will find it easier to reference the condition as it relates to the
circuit's function rather than remembering which channels of the analyzer were used to connect to
specific signals in the circuit.
DigiView's new trigger configuration screen centers the user's focus on function; making it much
easier to quickly analyze and modify a very complex trigger condition. The following graphic is an
example of an advanced trigger condition for the DV3 series.
(see: Trigger Configuration
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Example of an Advanced Trigger Configuration for DV3400:

2.3.2.1

Trigger Configuration
The new Trigger Configuration Screen introduces a dual-mode (GUI and text), schematic-like
approach to configuring the matches, sequencers and trigger output from a single window. A text
window shows the 'formula' for the configuration while the 'schematic' shows the flow. These two
sections update together to provide two distinct views of the configuration. Multiple trigger
configurations can also be selected and created using the selection area in the upper left corner of
this screen.
Trigger Configuration Selection

Multiple trigger configurations can be created and stored in the DigiView Data File. Use the
selection box to quickly chose another trigger
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configuration. After making a selection, click the "apply" button on the bottom of the screen for
the changes to take affect. To create, copy or rename a configuration, use the icon to the left
of the selection box to open the Trigger Selection Editor 49 .
Trigger Formula (left portion of screen)

The formula presents a summary of the complete configuration. Since this summary can be
quite involved with a complex trigger condition, each section will "highlight" as items in the
graphical section are selected or the mouse moves over them. The formula will automatically
scroll to bring the highlighted section into view while working in the graphical area of the
configuration. In the image above, the summary of "MATCH 2" is brought into view as Match 2
is selected (shown in blue below).
Schematic (right portion of screen)
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This area is where the actual configuration is accomplished.
Every trigger configuration starts with a match condition and ends with Trigger Out, so the
work flow is designed from left to right, starting with the Match Types (see: Match Types 31 ).
When the very first Match type is selected and the match condition has been specified, the
match will automatically be routed graphically to the Trigger Out. For the DV3 series, this
means it will route to TERMS 1, then the NON-Sequenced option and then to Trigger Out.
This automatic function is only performed if no other connections already exist. Once you have
started making connections for your trigger configuration, the software will not try to "guess"
your intentions. Since this would hinder your work and cause aggravation, the software allows
you to manually connect or disconnect if the action is valid. Only the obvious connect and
disconnects will be performed automatically.
NOTE: The graphical connections in the trigger configuration directly correspond to the
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physical circuit connections in the hardware, making this screen an overview of the resulting
logic in the analyzer's hardware.
See the Following Sections:
· Match Types 31
· Sequencer 48

2.3.2.1.1 Match Types

The DigiView trigger configuration supports multiple types of Match conditions. The available
match types depend on your model of analyzer. Details of each match type can be found using
the links below.
DigiView DV3 series analyzers have a total of 8 configurable match circuits and each can be set
to one of 9 different match types.

Setting the Match Type - A non-configured or "cleared" match will be identified by a "?" as seen
above. To set the match type, simply click on the cleared match and select the type from the
menu that appears.

Editing the Match Condition - When selecting or changing the match type, the editor for the
match condition will automatically appear. To edit the condition later, simply click on the match or
right-click on the match and choose "Edit" from the menu that appears.
Available Match Types:
·
·
·
·
·
·
·
·
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Stable 34
Equal 35
Not Equal 38
Greater Than 39
Greater Than or Equal
Less Than 43
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· Less Than or Equal

46

(See: Trigger Configuration

28

)

2.3.2.1.1.1 Pattern Match

The level trigger is a pattern match detector. You can configure it to match any combination of 0,1
or don't cares across all 18 (or 36) channels. The Pattern Match Editor is displayed below

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+" button to
add it to the Pattern Match. You can also just "Double-Click" the defined signal to automatically add it.
NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be added directly as a
complete signal. However, the individual portions of the signal (such as Enable above) can be added in
the same manner. To see the sub-portions of a signal, click the "expand" button in the left column next
to the signal's name, then add the sub portions in the same manner as any other signal.
For instance, if you have defined a State signal like the one above (Address) and you only want to
add the Enable signal to the pattern match, then expand it and double-click on Enable.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Pattern Match.
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Changing Bit Pattern - Each bit of the signal can be toggled between the 3 states of '0', '1' and 'x'
(don't care) by simply clicking on the bit position in the pattern edit area. To set all bits for a signal
to one of these 3 values, use the X, 0 and 1 buttons to the upper-right of the pattern edit area.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
Duration - Enter the stability duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the selected
signals (and bits) match the pattern for the indicated duration period.

2.3.2.1.1.2 Edge Match

The edge trigger circuit is a 36 (or 72) input OR of rising edge and falling edge detectors. You can
specify a trigger on rising, falling or transition on any combination of channels (rising edge of ALE
or falling edge of OE or falling edge of WT or transition on clock...). All '-' entries for a channel
means "don't care". The Edges Match Editor is displayed below

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it to the Edges Match. You can also just "Double-Click" the defined signal to
automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as :CLK
above) can be added in the same manner. To see the sub-portions of a signal, click the "expand"
button in the left column next to the signal's name, then add the sub portions in the same manner
as any other signal.
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For instance, if you have defined a State signal like the one above (Address) and you only want to
add the :CLK signal to the Edges match, then expand it and double-click on Enable.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Edges Match.
Changing Bit Pattern - Each bit of the signal can be toggled between the 4 states of '-' (don't
care), 'rising', 'falling' and 'either' by simply clicking on the bit position in the Edges edit area. To
set all bits for a signal to one of these 4 values, use the buttons to the upper-right of the Edges
edit area.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
2.3.2.1.1.3 Stable Match

The Stable Match type is only available on DigiView DV3 series.
All '-' entries for a channel means "don't care". The Stable Match Editor is displayed below.

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it to the Stable Match. You can also just "Double-Click" the defined signal to
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automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as :SCL
above) can be added in the same manner. To see the sub-portions of a signal, click the "expand"
button in the left column next to the signal's name, then add the sub portions in the same manner
as any other signal.
For instance, if you have defined an I2C signal and you only want to add the clock (:SCL) signal to
the Stable match, then expand it and double-click on :SCL. It would then appear on the right
portion of the editor as "AND I2C:SCL" like the OE signal above.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Stable Match.
Selecting Stable bits - Each bit of the signal can be toggled between the 2 states of '-' (don't
care) and 'STABLE' by simply clicking on the bit position in the Stable edit area. To set all bits for
a signal to one of these 2 values, use the buttons to the upper-right of the Stable edit area.
Boolean signals, if added, do not offer a choice and should be removed when they are no longer
needed as part of the Stable match.
Duration - Enter the stability duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the selected
signals (and bits) have been stable for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
2.3.2.1.1.4 Equal Match

The Equal Match type is only available on DigiView DV3 series.
The Equal Match Editor:
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ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the Equal Match. You can also just "Double-Click" the defined signal to
automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as the
'Data Channels' portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined an State signal and you want to add the Data portion of the
signal to the Equal match, then expand it and double-click on :Data Channels. It would then
appear on the right portion of the editor as shown above.
The Equal Match type only accepts one signal at a time. After a signal has been added, the "+"
(ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Equal Match.
Match Value Format - The value for the Equal Match type can be entered in Decimal, HEX,
Binary or ASCII format. The value will be limited to the maximum value allowed for the selected
signal, which will depend on the number of bit positions assigned to the signal. The formats for
entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
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HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the MSb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
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2.3.2.1.1.5 Not Equal Match

The NOT Equal Match type is only available on DigiView DV3 series.
The NOT Equal Match Editor:

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the NOT Equal Match. You can also just "Double-Click" the defined signal to
automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as the
Data Channel portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined a Synchronous Serial signal (i.e. SPI) and you want to add the
:Enable portion of the signal to the NOT Equal match, then expand it and double-click on :Enable.
It would then appear on the right portion of the editor.
The NOT Equal Match type only accepts one signal at a time. After a signal has been added, the
"+" (ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
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Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the NOT Equal Match.
Match Value Format - The value for the Not Equal Match type can be entered in Decimal, HEX,
Binary or ASCII format. The value will be limited to the maximum value allowed for the selected
signal, which will depend on the number of bit positions assigned to the signal. The formats for
entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the MSb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
2.3.2.1.1.6 Greater Than Match

The Greater Than Match type is only available on DigiView DV3 series.
The Greater Than Match Editor:
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ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the Greater Than Match. You can also just "Double-Click" the defined signal to
automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as the
Data Channel portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined a Synchronous Serial signal (i.e. SPI) and you want to add the
:Enable portion of the signal to the Greater Than match, then expand it and double-click on
:Enable. It would then appear on the right portion of the editor.
The Greater Than Match type only accepts one signal at a time. After a signal has been added,
the "+" (ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Greater Than Match.
Match Value Format - The value for the Greater Than Match type can be entered in Decimal,
HEX, Binary or ASCII format. The value will be limited to the maximum value allowed for the
selected signal, which will depend on the number of bit positions assigned to the signal. The
formats for entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
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HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the MSb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
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2.3.2.1.1.7 Greater Than or Equal Match

The Greater Than or Equal Match type is only available on DigiView DV3 series.
The Greater Than or Equal Match Editor:

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the Greater Than or Equal Match. You can also just "Double-Click" the defined
signal to automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc)
cannot be added directly as a complete signal. However, the individual portions of the signal (such
as the Data Channels portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined a Synchronous Serial signal (i.e. SPI) and you want to add the
:Enable portion of the signal to the Greater Than match, then expand it and double-click on
:Enable. It would then appear on the right portion of the editor.
The Greater Than or Equal Match type only accepts one signal at a time. After a signal has been
added, the "+" (ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
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selections) and click the "-" button to delete it from the Greater Than or Equal Match.
Match Value Format - The value for the Greater Than or Equal Match type can be entered in
Decimal, HEX, Binary or ASCII format. The value will be limited to the maximum value allowed for
the selected signal, which will depend on the number of bit positions assigned to the signal. The
formats for entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the MSb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
2.3.2.1.1.8 Less Than Match

The Less Than Match type is only available on DigiView DV3 series.
The Less Than Match Editor:
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ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the Less Than Match. You can also just "Double-Click" the defined signal to
automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc) cannot be
added directly as a complete signal. However, the individual portions of the signal (such as the
Data Channels portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined a Synchronous Serial signal (i.e. SPI) and you want to add the
:Enable portion of the signal to the Less Than match, then expand it and double-click on :Enable.
It would then appear on the right portion of the editor.
The Less Than Match type only accepts one signal at a time. After a signal has been added, the
"+" (ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Less Than Match.
Match Value Format - The value for the Less Than Match type can be entered in Decimal, HEX,
Binary or ASCII format. The value will be limited to the maximum value allowed for the selected
signal, which will depend on the number of bit positions assigned to the signal. The formats for
entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
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HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the Msb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
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2.3.2.1.1.9 Less Than or Equal Match

The Less Than or Equal Match type is only available on DigiView DV3 series.
The Less Than or Equal Match Editor:

ADD a Signal - Highlight a defined signal from the left portion of the window and click the "+"
button to add it as the Less Than or Equal Match. You can also just "Double-Click" the defined
signal to automatically add it. NOTE: High Level signal definitions (such as State, I2C, or etc)
cannot be added directly as a complete signal. However, the individual portions of the signal (such
as the DATA portion of a State Signal) can be added in the same manner. To see the
sub-portions of a signal, click the "expand" button in the left column next to the signal's name,
then add the sub portion in the same manner as any other signal.
For instance, if you have defined a Synchronous Serial signal (i.e. SPI) and you want to add the
:Enable portion of the signal to the Greater Than match, then expand it and double-click on
:Enable. It would then appear on the right portion of the editor.
The Less Than or Equal Match type only accepts one signal at a time. After a signal has been
added, the "+" (ADD) button will be disabled (as shown above) until the current signal is removed.
Note: If a signal is valid for the trigger configuration, a green icon will be displayed next to it.
Any other icon, such as the blue circle above on the Frame Sync channel of the Address
signal, indicates a channel state that is invalid for triggering. This particular icon indicates that
the channel has been configured as 'Ignored' in the signal definition editor.
Delete a Signal - Highlight a signal in the right portion of the window (or mouse-over its bit
selections) and click the "-" button to delete it from the Less Than or Equal Match.
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Match Value Format - The value for the Less Than or Equal Match type can be entered in
Decimal, HEX, Binary or ASCII format. The value will be limited to the maximum value allowed for
the selected signal, which will depend on the number of bit positions assigned to the signal. The
formats for entering each value type is described below.
Decimal: Enter any valid decimal value. An Invalid value will be cleared to 0 or assumed to be
HEX.
HEX: Start the value with an "x" or a "0x". If too many digits are entered, the most significant
nibble (leftmost) will be discarded. Any non-HEX digit will be ignored.
Binary: Enter "b" followed by "1's" and "0's". If too many digits are typed, the MSb (leftmost bit)
will be discarded. Any numerical value larger than a "1" or non-numerical character will be
considered a "1".
ASCII: Start the value with a single or double quote.
Duration - Enter the match duration by selecting the units then typing the value. The Maximum
Duration period for Model DV3200, DV3209, DV3400 and DV3409 is 5 ms; 10ms for Models
DV3100 and DV3109. The Trigger condition will not be considered as "True" until the entered
value for the selected signal has been valid for the indicated duration period.
Identifier - Change the identifier to something meaningful for the match condition if you do not
want the default "Match #" to be displayed in the formula and the graphical configuration area of
the trigger screen.
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2.3.2.1.2 Sequencer

The trigger circuit of the DV3 series includes 4 cascadable, 4 stage sequencers. These can be
chained in any combination to produce longer sequences ( 1@ 16 stages, 2 @ 8 stages...). Stage
inputs are OR gates so that more than 1 term of match conditions can be connected to each
stage. Each stage includes a 20 bit pass counter.

Setting the Counter
Double-Click in the counter to edit its value. When finished editing, either use the "Enter" or "Tab"
key to assign the new value to the configuration. Anytime the configuration changes, use the
"APPLY" button to activate the new settings.
NOTE: "0" is an invalid value, so the counter editor will enforce a minimum count of "1".
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2.3.2.1.3 Trigger Selection Editor

From this window, trigger configurations can be created, deleted, renamed and copied.

New Configuration
- Select the "+" button to create and add a new configuration.

Rename Configuration
- Select the "pencil" button to edit the name of the configuration.

Copy Configuration
- Highlight an existing configuration and select the "copy" button to create a new
configuration with identical properties. This is useful if you need a slightly modified version of a
complex configuration. Using the copy button will help you avoid re-configuring from scratch.

Delete Configuration
- Use the "delete" button to dispose of a configuration. NOTE: all deletions are final.

2.4

Analyzer Options
Each model of DigiView has a different set of options that can be adjusted directly from the
software. These options are shown summarized below.
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Model DV3100, DV3200 Hardware Options*

( * DV3200 Options Shown )

Sample Mode - Select the sample rate and channel mode.
Buffer Size - Adjust the amount of capture buffer (1% - 100%) to use in the Hardware.
Prefill - Adjust the amount of buffer to use for data captured before the trigger event. If no
trigger event occurs, the analyzer will continuously refresh this portion of the buffer with the
most recent data. When the trigger event occurs, the remaining portion of the buffer will be
filled with post-trigger data. The behavior of the prefill (or pre-trigger) portion of the buffer can
be modified by the Enforce Prefill option.
Enforce Prefill - Select this option to force the analyzer to fill the buffer to the Prefill setting
before looking for a trigger condition. If you do not need the full prefill amount before the
trigger condition occurs, then uncheck this option to allow early detection of the trigger.
Channel Monitor - This area displays the channel / color relationship and each channels
relative activity.
Trigger Threshold - Select the trigger threshold for the group of 18 Channels (9 channels per
cable). The selection can be made by highlighting one of the pre-defined values or use the
slider beneath these values to select a custom value. The valid range for the threshold on
model DV3100 and DV3200 is 0.5V to 2.8V.
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Model DV3109, DV3209, DV3409 Hardware Options

Buffer Size - Adjust the amount of capture buffer (1% - 100%) to use in the Hardware.
Prefill - Adjust the amount of buffer to use for data captured before the trigger event. If no
trigger event occurs, the analyzer will continuously refresh this portion of the buffer with the
most recent data. When the trigger event occurs, the remaining portion of the buffer will be
filled with post-trigger data. The behavior of the prefill (or pre-trigger) portion of the buffer can
be modified by the Enforce Prefill option.
Enforce Prefill - Select this option to force the analyzer to fill the buffer to the Prefill setting
before looking for a trigger condition. If you do not need the full prefill amount before the
trigger condition occurs, then uncheck this option to allow early detection of the trigger.
Channel Monitor - This area displays the channel / color relationship and each channels
relative activity.
Trigger Threshold - Select the trigger threshold for the group of 18 Channels (9 channels per
cable). The selection can be made by highlighting one of the pre-defined values or use the
slider beneath these values to select a custom value. The valid range for the threshold on
models DV3109, DV3209 and DV3409 is 0.5V to 2.8V.
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Model DV3400 Hardware Options

Sample Mode - Select the sample rate and channel mode.
Buffer Size - Adjust the amount of capture buffer (1% - 100%) to use in the Hardware.
Prefill - Adjust the amount of buffer to use for data captured before the trigger event. If no
trigger event occurs, the analyzer will continuously refresh this portion of the buffer with the
most recent data. When the trigger event occurs, the remaining portion of the buffer will be
filled with post-trigger data. The behavior of the prefill (or pre-trigger) portion of the buffer can
be modified by the Enforce Prefill option.
Enforce Prefill - Select this option to force the analyzer to fill the buffer to the Prefill setting
before looking for a trigger condition. If you do not need the full prefill amount before the
trigger condition occurs, then uncheck this option to allow early detection of the trigger.
Channel Monitor - This area displays the channel / color relationship and each channels
relative activity.
Trigger Thresholds - Select the trigger threshold for each group of 18 Channels (18 channel
models will only display 1 threshold setting). The selection can be made by highlighting one of
the pre-defined values or use the slider beneath these values to select a custom value. The
valid range for each threshold on model DV3400 is -6V to +6V.
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Acquisition Options

Display Behavior
These options control the default behavior when data is transferred for display on the screen.
This includes newly captured data and data loaded from browsing through the Capture History.

Do Not Change Position - When selected, the current time reference point remains the same.
The Waveform Views will remain at their current time reference instead of scrolling to the trigger
point or a selected marker position. NOTE: List windows always adjust to the time of the closest
matching line of data, so they may change position slightly, based on the new data loaded.
Scroll to Trigger - When selected, the waveform windows will scroll to the trigger point.
Scroll to Marker - When selected, the waveform views will scroll to the chosen marker. After
this option is selected, the Marker Selection options are available to make the marker selection.

Capture History Options
These options control when to save captures to the history, the amount of storage to use and
determine what action to take if these settings are exceeded. Changes to most of the options
below require pressing the "Apply" button in order to reconfigure the history buffer. If this is
required, the buttons will highlight with a red border to notify you. Pressing the "Cancel" button or
leaving the Acquisition option window (when the buttons are highlighted) will discard any
changes and restore your previous settings. When the apply button is pressed, the history will be
reconfigured to the new settings and the database rebuilt. If needed, some files will be deleted to
meet the new settings, starting with the oldest captures first.

Save capture History - When selected, each capture is stored in the history unless overridden
by a plug-in or Auto Search window.
Do Not Save capture History - When selected, each capture is discarded when a new capture
is acquired unless overridden by a plug-in or Auto Search window.
Delete History Files - When pressed, all capture history files for the current project will be
deleted, including the one being viewed. When opening a project file that does not have any
history, the data stored within the project file will be saved as a history file. If history files exist for
the project, but the current data is not found in the history, the data will be added to the history at
the proper chronological position.
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Limit by Number of Captures - Select this option to specify the exact number of captures to
keep. Once selected, the number of captures can be specified in the Maximum Number of
Captures to keep edit box.
Limit by Size on Disk - Select this option to specify the size of the storage space to use for the
capture history. Once selected, the size can be selected in the Maximum Disk Size for Capture
History editor on the right.
Limit by Disk Free Space - Select this option to specify the amount of free space to reserve on
the Hard Drive. Once selected, the size can be selected in the Minimum Disk Size to preserve
editor on the right.
Halt when limitation reached - Select this option to halt the analyzer if any of the limitations
specified above have been exceeded. A warning dialog will be displayed with information on
which limit was exceeded.
Overwrite when limitation reached - Select this option to automatically delete the oldest
capture(s) to make room for the newest capture when any of the limitations specified above
have been exceeded. The history will be maintained as a First in, First out (FIFO) buffer using
the parameters specified above. When limitations are reached, no warning is presented as this
configuration will automatically maintain the buffer using the specified limitations as new
captures are added.
History Monitor - For your convenience, the current Capture Count, Storage Size and Disk
Free Space are displayed to the right of the editors. This display is updated as capture files are
added or deleted and can be used as a History monitor while capturing.
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Color Themes
Several pre-defined color schemes and a custom scheme can be selected from the Color Theme
Selection window. This window is accessed from the CONFIG menu.

Theme Selection - Select "custom" if you would like to define your own colors, otherwise select
from one of the pre-defined color schemes. The Marker selection will be chosen automatically and
disabled for some theme choices.
Marker Selection - When selecting a theme, a compatible marker set will be automatically
selected. However, you can choose any of the marker "color sets" for the best marker visibility.
Selected Colors - These items display the current color values of the selected theme. To edit
these values, choose "custom" in the Theme Selection area, then click on the item in this section
that you would like to change.
Reset Signal Colors - Click this button to reset any Signal colors that do not match the current
color theme. Normally, changing the theme will also change a signal's colors. However, if you
have customized a signal's color, then it will not change with theme changes. To reset signal
colors, click this button and select an option from the menu that appears. To reset a specific
signal's colors without changing other signals, use that signal's editor instead.
Reset Custom to Theme - This will reset or change the colors of the custom theme to match any
of the pre-defined themes. To make the change, select the "Custom" theme, then click the button
and select one of the themes from the menu that appears.
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Theme Examples:
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Environment Settings
Several Environment options are available and can be accessed from the CONFIG menu.

General
Auto Save - Select this option to automatically save the current file. All current settings and
data will be saved to the file when exiting the program or opening another file. The "Notify
when Save Needed" option is disabled when this option is enabled. (see: Saving and
Restoring 129 )
Notify when Save Needed - Select this option if you want to be notified of unsaved changes
before exiting the program or opening another file. The "Auto save" option is disabled when
this option is enabled. (see: Saving and Restoring 129 )
Show Selections on Startup - Selected by default, this option presents a Choice of items to
load when the software is launched. De-select this option to skip the selection window on
startup. If disabled, the "Restore Last File on Startup" option will be enabled.
Startup Selections:
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Restore Last File on Startup - Select this option to skip startup options and automatically
load the last file used previously. If disabled, the "Show Selections on Startup" option will be
enabled (see: Saving and Restoring 129 ). If the last file used is missing then the Startup Up
selections window will open.
Play Trigger Sound - Selected by default, this option causes the software to present an
audible indication of Trigger events. In continuous run mode, the alert will sound only once on
repeated trigger conditions. De-select this option if you do not want the audible alert. The
Audible sound can be customized by using the Operating systems "Sounds" control applet.
Play Event Sounds - Selected by default, this option causes the software to present an
audible indication of any Snap or Scroll events. De-select this option if you do not want the
audible alert. The Audible sound can be customized by using the Operating systems "Sounds"
control applet.
Debug Plug-ins - Select this option to have the DigiView software pause when loading a
custom plug-in. A message dialog will open and DigiView execution will wait until you close the
dialog. This provides a means for the developer to attach the DigiView process to an external
debugger before the plug-in module begins to execute.
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Wave Form Views
Vertical Lines - Check this option to display vertical lines at the time divisions in the Wave
Form views.
Reference Line for @ - Check this item to display a vertical line at the time reference marker
(@) of the Wave Form views.
Horizontal Lines - Check this option to display a horizontal line beneath each visible signal in
the Wave Form views. This may be desired to help determine the state of multiple Boolean
signals when zoomed in at maximum resolution.
Snap to Frames - Check this option to snap to frames by default and use the shift key to snap
to fields. If unchecked, the default is to snap to fields and use the shift key to snap to frames.
This option affects all marker and signal snapping features of the waveform view.
Reset Row Height - Click the "Apply" button to reset the heights of all signals in the Wave
Form displays to the value entered as the Current Default size. Edit the current value to
enable the "Apply" button.
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Capturing Data
Once signals 8 and triggers 27 are defined, you can capture a new buffer of data at any time by
pressing the 'Run' or 'Auto Run' buttons. If you tire of waiting on a trigger or it triggers but you tire of
waiting for it to fill up the buffer, you can STOP the capture to transfer the capture buffer to the
screen. When transferred to the screen, the capture is also stored in the capture history for later
analysis (based on Acquisition settings 53 ).

Preview - This mode will automatically transfer data to the PC repeatedly even if a
trigger condition has not been defined. This mode is very useful to Monitor signals while making
connections and only utilizes a small portion of the hardware buffer. In this mode, the buffer size
and duration of data collection is adjusted automatically to provide a "peek" of the logic activity
and is not intended for normal data analysis. The result is a virtual "LIVE" mode that does not try
to search the data (Auto Search windows) or store the data in the capture history. The data
displayed will be discarded when the results of a normal Run (single shot) or Auto Run are
displayed.
Auto Run - This will "ARM" the hardware, wait for the trigger condition, automatically
transfer the data to the PC when the buffer is full and automatically re-arm to repeat the process
until the Stop or Halt button is pressed. If you are waiting on a Trigger condition that you expected
to occur, you can select the "Stop" button to view the data already collected in the pre-fill portion of
the hardware buffer (see Analyzer Options 49 ).
Run - This will "ARM" the hardware and automatically transfer the data to the PC
when the buffer is full. If you do not want to wait for a long capture, you can select the "STOP"
button to force a transfer of the current data captured. If you are waiting on a Trigger condition
that you expected to occur, you can select the "Stop" button to view the data already collected in
the pre-fill portion of the hardware buffer (see Analyzer Options 49 ).
Stop - This will halt the capture and transfer whatever was captured to the PC for your
analysis.
Halt - This will reset the hardware and abort the capture without changing the data
currently being analyzed. When the halt button is pressed, no data is transferred to the screen or
the Capture History.
When you click on 'Run' (or Auto Run), you are actually arming the trigger circuit. Upon trigger, the
hardware allows the buffer to continue past the pre-fill point and to continue filling up (post-fill). Once
the buffer is full, it is transferred to the PC. After the buffer is transferred, the hardware immediately
resets and begins pre-filling in preparation for the next RUN. In Auto Run mode, the next Run starts
automatically.
· Hardware Status 63
· Capture History 64
· Capture Troubleshooting
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Note that the DigiView hardware is always capturing and storing data in a circular queue. While you
are looking at the last capture, the hardware is pre-filling the buffer to the pre-fill size selected. When
the buffer reaches the pre-fill setting, the hardware continues capturing and storing data in a circular
queue fashion so that the most recent data is always available while waiting on the trigger condition.
(see also: Acquisition Options

53

, Analyzer Options

49

, DigiView Compression

133

)
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Hardware Status
The lower right corner and the upper right corner of the main window display Hardware Status
information. This information will keep you informed of the hardware's buffer usage and capture
state.
Buffer Usage

The hardware buffer's usage is displayed as a bar graph and numerical percentage indicating
the used portion of the buffer. As data is stored in the buffer. the bar and the percentage will
increase. When the buffer reaches 100%, the data will be transferred to the PC for analysis.
The buffer may take mere milliseconds to fill or up to months to fill depending on the signals
defined (see: Signals 8 ) and the amount of activity on those signals. If you have configured
the buffer's prefill option to 'forced' (no early trigger), the buffer indicators may appear to stall.
This is correct behavior when very little or no signal activity is present or when the analyzer is
waiting for the trigger condition.
During a "waiting for Trigger" period, the analyzer continues to capture and store the newest
data in the prefill portion of the buffer, while discarding the oldest data. Once the trigger event
occurs, the buffer will stop discarding the oldest data, keep the newest data (the prefill portion)
and continue to capture until the buffer is full (see: Enforce Prefill in Analyzer Options 49 ).
To clear the buffer, click on the percentage indicator.
Analyzer State
The upper right corner of the main window will display the current state of the Analyzer using a
"light Bulb" symbol and a short text message (next to the run buttons), while the lower right
corner will display the state of the hardware as simple LED indicators with a letter abbreviation
for a reminder.
Message Example:

The 'Light Bulb" is lit, indicating that a trigger event occurred. The current status is
"Post-Filling", indicating that the remainder of the buffer is being filled with post-trigger data.

Indicator Example:
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The status LEDs above indicate that the unit is powered, a trigger event has occurred and
the remainder of the buffer is being filled with post-trigger data. Descriptions of each LED
are provided below.
P
H

Powered - The analyzer has been detected and is powered.
Halted - The analyzer is 'IDLE' or waiting for a RUN command.

P
Pre Filling - The analyzer is capturing data and filling the 'Pre-Fill' portion of the
buffer.
A
Armed - The analyzer is Armed and actively looking for a trigger condition.
T
Triggered - The analyzer detected a trigger event.
P
F
X

Post Filling - The remaining portion of the buffer is being filled with post trigger data.
Full Buffer - The buffer is full.
Transferring - The analyzer is transferring the compressed buffer to the PC.

The typical progression of the status indicators is from left to right.

3.2

Capture History
As data for a project is captured and transferred to the PC, it is stored on the Hard Drive as a
history buffer and maintained according to the settings configured in Acquisition Options. Each
project maintains its own history buffer in a sub folder using the same name as the project file.
However, the project file does not require the history buffer to be present when opened. This
allows the project file to operate as a 'stand-alone' file for sharing or archival purposes. When
saving the project file, the currently loaded capture will be the data stored in the project (see also:
Acquisition Options 53 ).
History Browsing
The history buffer can be accessed utilizing the History Menu, the Browse button or the bar
graph. These items are located at the bottom of the main window. When browsing the history,
the data for that history item will be loaded and all Signals, Auto Searches, Lists, Tables, etc.
will refresh as if the data had just been captured.

Menu Button
Click the Menu button to display the Capture History Menu:
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Browse Button
A Left-Click or Right-Click on the browse button will load the previous or next item in the
history buffer. Holding the mouse down will repeat the action in the same direction, causing
an "Animation" of the history.
Search History Button
Click this button to open the Capture History Search. This allows a search of the entire
capture history using any normal search displayed in the Global search or the Search
Manager (see History Searching below).
Bookmark Button
Click the Bookmark button to toggle a bookmark for the current capture. If already
bookmarked, then the bookmark is cleared.
Bar Graph
Click on the bar graph to "jump" to different items in the history.
Click and drag the mouse in the bar graph to display the history item number to be loaded
when the mouse is released.
The triangle in the bar graph indicates the current position in the buffer.
The small squares represent a bookmarked item which will also be listed in the history's menu
for quick access.
The numbers in the top-left portion of the bar graph represent the Capture ID Number, the
Position of the current capture in the buffer and the Total number of captures stored (in that
order).

History Searching
The entire captured history can be searched forward and backward to find a capture with a
search result that matches the halt qualifier specified.

© 2014 TechTools

66

DigiView User's Guide

Selected Search
Any search that you have defined for this project will be listed in the search selection
drop-down box. Choose the search you want to use from this selection (see Searches
Searching 93 ).

91

,

Halt Qualifier
Select the Logic (>, <, =, <>, <=, >=) and enter the count for the search to match. Most of the
time you may be looking for any file that results in a single match or more and would set the
logic to ">=" and the count to "1". However, you may be looking for the "odd" capture that has
far fewer or greater matches than the other captures so we have allowed for values up to 32
bits to be specified for the count.
Include Start Position
This option controls whether the search includes the file at the current position or not. Check
this option to include the current position when the search begins (forward or backward). This
box will be set automatically if the selected search is changed or on any changes to the halt
qualifier. This option is automatically cleared when the search of a capture file results in a
match, which saves you the trouble of manually clearing it if you re-start the search.
Backward
This button starts the search from the current position and proceeds towards the oldest
capture until a match is found or the oldest capture has been searched. The file at the current
position is only searched when the "include start position" option is selected.
Forward
This button starts the search from the current position and proceeds towards the newest
capture position until a match is found or the newest capture has been searched. The file at
the current position is only searched when the "include start position" option is selected.
Cancel
This button stops the search.
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Close
This button closes the search window. The close button will not be available if a search is in
progress. Cancel the search if you want to close the window. When the window closes it will
remember your current settings.
When the search is halted or stops automatically, the capture file at the stopped position will
be loaded and all windows updated with the new data.
No Matches found or Cancel example:

Match found Example:
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Capture Troubleshooting
Symptom
1. DigiView (Models DV3100, DV3109,
DV3200, DV3209 and DV3409) Power LED
does not stay ON.

Causes & Solutions
(A). The USB subsystem of the PC is turning
DigiView Off due to a Bandwidth shortage.
REMEDY: Remove other USB devices that
use a port on the same hub (internal or
external).
(B). The USB subsystem of the PC is turning
DigiView Off or DigiView is resetting due to
insufficient power.
REMEDY: If you are using an external hub,
change to a POWERED external hub or
purchase one of better quality that meets USB
specifications.
(C). The USB cable is not designed for High
Bandwidth applications, causing
communication errors.
REMEDY: Replace the USB cable with one
designed for the High Speed mode of the USB
port.
(D). The USB cable is connected to a case
port that utilizes a low bandwidth cable
internally, causing communication errors.
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Causes & Solutions
REMEDY: Connect DigiView to a port located
directly on the Motherboard (rear port of the
case).

2. DigiView is only identified as a SERIAL
device by the USB subsystem.

(A). The USB sub-system is experiencing a
problem with corrupted or missing files.
REMEDY: Look for a driver update to the USB
hub (internal or external) or re-install its
drivers. Refresh the DigiView drivers by
re-installing the DigiView software.
(B). Operating System or computer needs
rebooted.
REMEDY: Turn off the computer and re-boot
the system.
(C). The USB cable is not designed for High
Bandwidth applications, causing
communication errors.
REMEDY: Replace the USB cable with one
designed for the High Speed mode of the USB
port.
(D). The USB cable is connected to a case
port that utilizes a low bandwidth cable
internally, causing communication errors.
REMEDY: Connect DigiView to a port located
directly on the Motherboard (rear port of the
case).
(E). The DigiView hardware has been
damaged.
REMEDY: Call Technical Support for repair
information.

3. One of DigiView's channels is connected to
a transitioning signal, but the capture does not
seem to show any activity or very little activity.

(A). The resolution of the Waveform View is
too low to see the activity.
REMEDY: Zoom In to see the details of the
activity.
(B). The signal has been defined with the
wrong channel selected.
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Symptom

Causes & Solutions
REMEDY: Edit the signal definition and
change the channel selection. The colors are
repeated for each group of 9 channels, so be
sure to select the correct one.
(C). The signal definition has been "disabled".
REMEDY: Edit the signal definition and
uncheck the Disabled option. The channels for
disabled signals will not appear in the
captured data.
(D). Bad Ground reference.
REMEDY: Connect one of DigiView's ground
wires (black probes) to a ground point as
electrically close as possible to the signal
connections.
(E). Incorrect Trigger Threshold.
REMEDY: The transitions will be
undetectable If the trigger threshold is set too
high or too low for the voltage range of the
transitioning signal. Change the Threshold
setting for the physical channel so that it is
near the center of the signal's voltage swing.
(F). Insufficient power or Communication
error, see 1.B,1.C,1.D above.
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Navigating and Analyzing the Data
This is where you spend most of your time; trying to make sense of what you captured. You will
find DigiView software very intuitive and easy to use but it is important to realize that ZOOM
operations occur about the CENTER of the screen. The tools are all designed to take
advantage of this fact to make you more productive.
The general paradigm is to find points of interest, bring them to the center of the screen and then
ZOOM. We provide several methods of finding edges and bringing them to the center of the
screen so that you can zoom in and out without having to constantly scroll to 'zero-in' on the point
of interest.

Navigation, Markers & Buttons:
·
·
·
·
·
·

Waveform Views 72
Using Markers 75
Marquee Zoom 79
Toolbar Buttons 79
Bird's-Eye View 81
Hot-Keys 82

Viewing the Data in Time-Relative Columns:
· Table Windows 84
· List Windows 87

Linking Views into Time-Relative Groups:
· Using Link Groups

90

Searching the Data:
·
·
·
·
·

4.1

Search Overview 91
Define Searches 91
Searching 93
Search Manager Windows
Search Types 96

93

Waveform Views
Wave Form views are the central focus of navigating and analyzing the huge amount of
captured data. In the waveform views you can Zoom quickly to different resolutions (without
throwing data away), snap to edges or beginning of packets, drop markers to correlate time
between transitions and much more.
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Waveform View Function Summary
· View multiple signals in time correlation.
· Expand Multi-Channel Signals to see individual channel waveforms by using the " + "
symbol to the left of the signal name.
· Individually reverse Expand Order of Multi-channel signals by menu.
· Collapse expanded Multi-Channel Signals by using the " - " symbol to the left of the signal
name.
· Zoom in or out for more or less resolution.
· Single button Zoom Max resolution or Zoom Min resolution.
· Marque to Zoom function. (see: Marque Zoom 79 )
· Scroll by a single division or Page multiple divisions.
· Free Scroll vertically and horizontally by a Right-Click Drag.
· Link both Waveform Views at the center time for Synchronous Scrolling regardless of
each view's zoom level. (see: Using Link Groups 90 )
· Drop Marker arbitrarily by Ctl-Drag or Drag & drop in the topmost row.
· Snap Markers to next or previous transition of a signal by Drag & drop. (see Cursors and
Markers 75 )
· Snap Markers to next or previous transition and Bring to Center by Shift-Drag.
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· Snap Signal to the next or previous transition by using the " <, > " indicators to the right of
the signal.
· Arbitrary Snap to center and Edge Snap to center by a Left-Click anywhere on a signal.
· Set, Clear or Jump to markers.
· Signal Row Order can be re-arranged by dragging.
· Bus Signal Format can be set to HEX. Decimal or Octal.
· Independently select which signals to view in each Waveform View.
· Edit Signal Properties by menu or Left-Click on the signal's name. (see: Signal Editors 10 )
· Print current Waveform View or Save as JPEG. (see: Printing 121 )
Waveform Pop-UP Menus
To access the main waveform menu, click the menu button (shown on the left), the
topmost row or the left column of the waveforms. To access a signal specific menu,
Right-Click on a Signal name.
Waveform Menu:

Waveform Signal Menu:
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Using Markers
Markers
Six markers (M1, M2, M3, M4, M5, M6) are provided. Markers have several uses. They can be
used to measure time or signal specific measurements, to 'bookmark' locations and to help
bring data to the center of the screen.
The Status window shows the current time of each marker (relative to TRIGGER) as well as
additional information for the current capture.

Whenever a marker becomes the Active Marker, its corresponding information will
automatically highlight in the Status Window and if assigned to a signal (assigned = being
dragged over a signal or dropped on one in the Waveform View), measurements for the signal
are displayed for adjacent marker pairs in the Measurements Window. The measurement
displayed is determined by the type of signal the active marker is assigned to.
In the image below, marker "M3" is the active marker and it is assigned to an Asynchronous
signal definition named "ASYNCTX".
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Drag to place
Simply click on a marker and drag it to the area of interest. You can grab the marker itself
(the vertical line in the waveform area) or its 'flag' (the rectangle at the top of the window).
Notice that the flags are offset so that even when they are overlapped, you can still grab
them. When your mouse is in the capture zone for a marker, the cursor changes to indicate
that it is over a marker. The cursor also indicates which marker would be selected, making it
easier to grab a specific marker when they are very close together (or even on top of each
other).
Quick Select Flags
Sometimes markers are invisible, buried behind other markers or off-screen. You can easily
grab any marker from the quick-select flags at the top right corner of the window, regardless
of their current position or visibility.
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Dragging from these flags will bring the marker to the current screen position and make it
visible if necessary.
Clicking on one of these flags will automatically scroll the waveform view to the markers
position and center it in the waveform window. This can also be referred to as "Jump to
Marker".
Auto-Snap
'Snapping' the markers to signal edges makes it easy to measure the time between them or
to bring a specific edge to the center of the window. This operation is used so often that we
optimized it by making it an automatic function. When you are dragging a marker and your
mouse is over a waveform, the cursor changes to a 'snap-left' or 'snap-right' arrow. The
direction of the arrow shows you which edge (previous or next) of this waveform the marker
will 'snap' to if you were to drop it at that point. The arrow will point to the nearest edge or to
the nearest edge in the direction of mouse movement, even if that edge is off-screen.
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If you do NOT want to SNAP, but rather wish to drop the marker exactly at the mouse
position, you can either hold down the control key or move your mouse above or below all
waveforms before releasing the mouse button.
Auto-Snap & Bring to Center
Hold the SHIFT key when 'Snapping' the markers to force the "snapped-to" edge to the center
of the screen.
Drop & Bring to Center
Hold both the SHIFT key and the CTRL key when dragging a marker to "drop" the marker
and bring the drop point and marker to the center of the screen.
Right Click Popup
Right clicking on the name of the signal (or in the top margin) opens a pop-up menu with easy
access selections to bring a marker to the center of the window, or to clear one or more
markers. This provides another method of Setting, Clearing and Jumping to markers. If you
click on the signal's name, then this popup menu will also include signal specific options.
Active Marker
Any action that uses a marker will automatically designate that marker as the "Active Marker".
The active marker exposes additional properties and associated items for easier navigation
and support to 'bring the data to center' concept.
Waveform Association
When you snap a marker to a waveform, it becomes associated with that waveform as
indicated by the usage of the marker's color in the Active Marker Column on the right. In
the image below, Marker M2 is associated with ASYNCTX and the value of ASYNCTX at
the marker position is 'E' as shown in the Active Marker Column.

To associate the Active Marker to another signal, click in the Active Marker Column of the
signal. To SNAP the Active Marker to the next edge of the signal after it is associated, right
or left click in the active marker column of the associated signal (or use the Snap Left/Right
button)
Snap Left/Right
To snap the active marker to the previous or next edge of the associated waveform, either
right or left click in the Active Marker Column or on the dedicated snap button next to the
Active Marker Column's marker identifier. In the image above the identifier is "2" and the
dedicated button is the same color as marker M2.

This allows one to walk any marker from edge to edge on a specific signal. To walk
through two different sections of data or two different signals, simply select each desired
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marker using the Quick Select flags. Each marker maintains its position, allowing one to
jump back and forth between them. You can walk one signal for a while, jump to the other
marker and walk that signal and then jump back to the first marker and pick up where you
left off.
Left-Click to Snap Left.
Right-Click to Snap right.
Marker Tack
The button just above the Active Marker's snap button will toggle the "Tack" feature of the
marker. When the button is pressed tacking is enabled. When the Tack option is active,
snapping the marker will bring the data to the position of the '@' time reference instead of
moving the marker out of view. When tacked, the button displays in the same color as the
active marker.

You can still drag the marker (with or without auto-snap) to another point in the data, but
when you release the mouse button, the marker AND the data will be brought to the center
of the screen, ready for zooming in/out.
TACKing a marker is particularly useful for walking though a signal, edge by edge.
Normally, when you SNAP the a marker, the marker moves to the previous or next edge of
the associated signal. When the marker is tacked, the DATA is brought to the MARKER
(and the screen's '@' time reference). This allows you to walk through the data without
continually re-centering the screen. It also supports our 'bring the data to the center..THEN
zoom' paradigm.
Note that this is an intelligent TACK. It does NOT freeze the marker at the screen center. It
brings the marker to center any time you move the marker (by dragging, snapping or
setting its position). This allows the marker to stay at a specific TIME/EDGE if you scroll the
screen or jump to another marker. The next time you attempt to move the TACKed
marker, it will move relative to the place you left it, then bring it and the data to the window's
center. For example, we will assume that you have enabled the Tack option for both M1
and M2 markers. While you are moving/snapping the M1 marker, it stays as the center.
You can jump to the M2 marker and it starts tacking at the center. At any time, you could
jump back to the M1 marker (by clicking on the Quick Select flags in the upper right
corner).

4.3

Marquee Zoom
You can use your mouse to marquee an area of data to zoom in on. Click and drag to marquee a
section. When you release the mouse button, the enclosed area will pan to the center of the
screen and them zoom in as much as possible while keeping the entire area on the screen.

4.4

Toolbar Buttons
We make extensive use of the right mouse button. Most functions have naturally paired
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operations. Most paired functions are natural opposites (like left/right, in/out, first/last,
previous/next). Others are not opposites but still naturally paired (like X/Y). We take advantage of
this symmetry to double up the functions of most buttons and other clicks. This not only reduces
desktop usage but also results in more natural, easier to remember functions.
For example, rather than having separate SEARCH LEFT and SEARCH RIGHT buttons, we have
a SEARCH button. Left clicking the button will SEARCH LEFT; right clicking will SEARCH RIGHT.
After only a few minutes of use, this becomes much more natural than using separate buttons.
Switching directions involves pressing different mouse buttons rather than moving the mouse to a
new button in the application. All buttons in the tool bar above the Waveform View are
dual-function. Additionally, you will find that left and right clicking on the " < " and " > " symbols,
Active Marker column and various other buttons will perform similarly paired functions.

Goto Trigger / Goto M1+M2
Left Click - Go to the Trigger Point Cursor
Right Click - Go to the midpoint of the M1 and M2 Marker, then Zoom to Fit in view

Goto M3+M4 / Goto M5+M6
Left Click - Go to the midpoint of the M3 and M4 Marker, then Zoom to Fit in view
Right Click - Go to the midpoint of the M5 and M6 Marker, then Zoom to Fit in view

,

Link / Unlink Waveform Views

Down Position - Waveform views are LINKED for Synchronized Scrolling (first graphic above)
Up Position - Waveform views are NOT linked, allowing independent scrolling (second graphic
above)
When Linked, all members of Link Groups 1 and 2 will also be linked. (see: Using Link Groups
90 )

Previous View / Next View
Left Click - Navigate backward in the waveform view's Scroll & Zoom history.
Right Click - Navigate forward in the waveform view's Scroll & Zoom history (if you have
already navigated backward).

Scroll by 1
Left Click - Scroll left by 1 division. LEFT means to scroll the view window to an earlier point in
time. (hold to repeat)
Right Click - Scroll right by 1 division. Right means to scroll the view window to a later point in
time. (hold to repeat)

Scroll by 5
Left Click - Scroll left by 5 divisions (1/2 screen) (hold to repeat)
Right Click - Scroll right by 5 divisions (1/2 screen) (hold to repeat)

Scroll Start/End
Left Click - Scroll to START of data
Right Click - Scroll to END of data
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Search
Left Click - Search Left to previous match using selected Global Search
Right Click - Search Right to next match using selected Global Search

Search Edit
Click to Edit selected Global Search

Waveform View
Click to change Waveform view to SINGLE or SPLIT view

Zoom In/Out Max
Left Click - Zoom IN ALL the way (Highest Resolution)
Right Click - Zoom OUT ALL the way (show ALL data)

Zoom In/Out
Left Click - Zoom IN one step (more detail, more resolution) (hold to repeat)
Right Click - Zoom OUT one step (less detail, less resolution) (hold to repeat)

4.5

Bird’s-Eye View
The BirdsEye window gives you the really big picture. It shows the relative zoom and position of
the two waveform windows and the total data. The total data is show with a horizontal line down
the middle and 'goal-post' lines on the ends. The primary waveform window is represented with a
different color (lighter in this example) rectangle in the top half of the display. Likewise, the
secondary waveform window (if visible) is represented in the bottom half of the window.

When the window is zoomed in on a small percentage of the data (usually the case) the waveform
representation becomes a small circle so that you can still see it. Otherwise it would degenerate
into a very thin line.

As you navigate through the data, you can look at the BirdsEye to see exactly where you are in the
data and how fast you are progressing through it. When you have both waveform windows open
you can see their relative zoom levels as well as positions. If they are linked to each other, you will
notice that they move together through the data.
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Each of the markers are also shown with color-coordinated lines.
You can click on the BirdsEye window to position a waveform window in the area of the data
clicked on. If the secondary waveform window is open, then clicking in the bottom half repositions
the secondary waveform. If you click near one of the markers, the waveform will "snap" to the
markers position. Clicking in the top half repositions the main waveform. If the secondary
waveform is not visible, then clicking anywhere in the window repositions the primary waveform
window.
Press and hold the 'I' or 'O' keys to see the affect on the bird's-eye while zooming in and out. In the
example below, the top waveform view is zoomed to a large portion of the available data and the
lower waveform view is zoomed out far enough to see all the data. The data is represented by the
taller rectangle (darker color in this example).

4.6

Hot-Keys
The HOT-KEYs are not expected to replace a mouse, but rather, supplement it. When analyzing
lots of data, it can be useful to use the keyboard for say, ZOOMING and SCROLLING while using
the mouse for cursor control.

1, 2, 3, 4, 5, 6
(without shift) GOTO marker (M1, M2, M3, M4, M5, M6)
(with SHIFT) SETS marker (M1, M2, M3, M4, M5, M6) to the current '@' time reference.

I,O
(without SHIFT) Zoom IN/OUT one step (hold to repeat)
(with SHIFT) Zoom MAX IN/OUT

P
Preview (initiate a repeated, short capture, ignoring trigger criteria)

A
Auto Run (initiate a repeated capture, honoring all trigger criteria)

R
Run (initiate a capture, honoring all trigger criteria)

S
Stop (stops a capture, transfers available analyzer buffer to the PC)
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H
Halt (stops a capture, discards any partial buffer in the analyzer)

T
GOTO Trigger point

Z
Zoom and pan to bring both markers M1 & M2 into view

<,>
(without SHIFT) Scroll LEFT or RIGHT 1 division (hold to repeat)
(with SHIFT) Scroll LEFT or RIGHT 5 divisions (1/2 screen) (hold to repeat)

[,]
Scroll to START or END of data

Ctrl+Drag Window
Holding the control key while dragging a window will temporarily turn off the docking prompts so a
window can be positioned without docking.

Shift+Snap
Holding the shift key, while snapping a signal or the active marker to the next data change in the
waveform view, will toggle the snap between Field/Frame modes (depending on the "Snap to
Frames" environment setting). This option is only available when framing information is contained
within the signal.

Alt+F
Open the FILE menu

Alt+C
Open the CONFIG menu

Alt+S
Open the SEARCH menu

Alt+W
Open the WINDOW menu

Alt+H
Open the HELP menu
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Table View Windows
Table views present the data as a list of numbers (tabular form). Table windows can be created
after a signal of any type is created. To create a Table view, select any of the signals presented
on the New Table submenu of the Window menu. Some signals in the menu will have "(raw)"
appended to the signal name. These signals can be added to a Table view in their raw data
format, but are better viewed in their decoded format using a List view. (see: List Views 87 )

·
·
·
·
·
·
·
·

Multiple tables can be created and viewed simultaneously.
Multiple signals can be viewed with each signal in a separate column.
Multi-Channel Signals can be "expanded" to multiple columns.
Expand order of Multi-channel signals can be reversed.
Signal column order can be re-arranged by dragging.
Bus Signals can be formatted as Binary, HEX or Decimal.
Time Display can be set to Auto, ns, us, ms, sec, min, hrs, days or weeks.
Time Format can be set to Delta or Absolute.
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·
·
·
·
·
·

Time Column can be hidden.
Set, Clear or Jump to markers. (see Cursors and Markers 75 )
Assign Time Synchronized Link Group. (see: Using Link Groups
Select which Signals to view in each Table.
Edit Signal Properties. (see: Signal Editors 10 )
Print current Table View or Save as JPEG. (see: Printing 121 )
Export data using Table's settings. (see: Exporting Tables 117 )

90

85

)

While most manufacturers provide table views, they generally are not too useful for anything
other than STATE mode signals. Most logic analyzer demos will show data changing on every
sample, making the table view look interesting in timing mode. However, in real usage, most
signals do not change at anywhere near the sample rate, causing the table to show a small
sample of stable data. You might have to scroll several screens before seeing the signal
transition. We have added several enhancements to the basic table view to make them truly
beneficial in real-world usage.

Compressed View
This mode compresses out the 'dead-time' between transitions, packing a lot more
information into a screen of table data. Each line of data in the table contains the
timestamp and the data. The time between lines varies and corresponds to the length of
time the previous sample was stable. In this mode, a 40 line table contains 40 transitions.
In linear (non-compressed) mode, it would contain 40 SAMPLES with perhaps NO
transitions. If multiple signals are added to the table, the compression algorithm takes ALL
signals in to account. A new line is shown any time ANY of the signals change state.
Nothing is lost or thrown away. We simply compress out the redundant information,
making the table hold more significant data. You can switch between compressed and
linear views with a single click at any time.
Although compressed mode is the most efficient way to display a signal in tabular form,
some people have trouble visualizing the non-linear, compressed time. You can Link a
compressed table with other non-compressed tables or with waveform displays to
correlate the data to a linear view. This allows BOTH an efficient table view and a linear
'in-context' view.
The included '8051.dat' example demonstrates this well. The OE signal in that example is
spread across about 1.4 Million samples but can be displayed in less than 20 table lines
when compression is enabled. When this table is linked to a waveform view, scrolling
through this small table quickly scrolls the waveform to each significant event in the OE
signal. This is a real-world example captured from a real embedded system.

Down Sampled View (Zoom)
Another approach to making the table view useful in normal timing modes is to use
down-sampling. This mode presents the data in a time-linear format, but down-samples
the data to reduce information. Down-sampling preserves linearity but reduces resolution.
This is similar to turning down the sample rate while capturing data to extend capture
times at the expense of resolution. Of course the key difference is we are post processing
the data for the table view; not ignoring data during capture. In this mode, we are simply
displaying the data with less resolution to allow the user to see more transitions while
maintaining a linear time view. Since we have not changed the underlying data itself, you
can 'zoom in' (reduce down-sampling) at any time to see more detail and actual timing.
You can also link to other full-resolution tables or waveforms to get a simultaneous view of
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the full detail and the data's correlation to other signals.

Delta vs. Linear time
Regardless of the display mode( normal, compressed or down-sampled), you can display
the time field in absolute or delta time. Absolute is the actual timestamp of the sample
(relative to trigger). DELTA mode shows the time between table lines. This is most useful
in compressed mode where it tells you the time between transitions. In normal and
down-sampled modes, it simply tells you the sample rate( since the time between each
line is constant).

Table Menu
The table's menu offers several useful functions such as navigating to a reference point,
adding additional signals, configuring the time and so forth. To activate the menu for a
specific signal from within the table, right-click in the signals' column. Examples of these
menus are displayed below.
Table General Menu:

Table Signal Menu:
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List View Windows
List views present the decoded data of higher level signal types in column form. List windows can
be created after creating a signal definition that supports decoding (such as I2C). All signals that
use decoding or any Plug-in signal can be displayed in the List window. The only signals that can
not display in the List window are Bool, Bus and Analog. To create a List view, select any of the
signals presented on the New Decoded List submenu of the Window menu. These signals can
also be presented in their raw data format using a Table view. (see: Table Views 84 )

·
·
·
·
·
·
·
·
·
·
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Multiple lists can be created and viewed simultaneously.
Time Display can be set to Auto, ns, us, ms, sec, min, hrs, days or weeks.
Time Format can be set to Delta or Absolute.
Time Column can be hidden.
Set, Clear or Jump to markers. (see Markers 75 )
Assign Time Synchronized Link Group. (see: Using Link Groups 90 )
Select which Signal to view in each List.
Edit Signal Properties. (see: Signal Editors 10 )
Print current List View or Save as JPEG. (see: Printing 121 )
Export data using List's settings. (see: Exporting Lists 116 )
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List Views have several options to change what data to display and how the data is displayed.
These options are accessible from the top bar in the window and can be used in combination.
Some examples of the display options are shown below using an I2C signal.
Time Column:

Time Column, Name:

Time Column, Name, Frames:
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Menu:
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Using Link Groups
Link groups provide Synchronous Scrolling of a group of windows that display data. When
several windows are part of the same Link Group, each window will automatically update and
scroll when any member of the group changes its center time. The time reference and displayed
data of each member will "center" on the time the changing member centers on. This feature
keeps a group of windows synchronized to the same time in the captured data.
DigiView provides five link options that include Link Groups 1 through 4 and a "no-link" option for
windows that you want to keep independent.
Default link groups:
Link Group 1 this group.
Link Group 2 Link Group 3 Link Group 4 -

Waveform View 1 is always a member and all new windows initially belong to
Waveform View 2 is always a member of Link Group 2.
Empty Group, ready for members.
Empty Group, ready for members.
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The link group of any window that displays data (such as Tables and Lists), can be changed at
any time. To change the group in these windows, select the window's menu, then choose the
desired option from the submenu of the "Link" item. The options on this menu are displayed in
the following Graphic.

All windows or views that can be assigned to a link group, will have a visible indicator with the
group number or an " * " (asterisk) displayed. The asterisk indicates an independent window
that is not linked to any group.
Typical Link Group indicators:
,

,

NOTE: When Waveform View 1 is "cross-linked" to Waveform View 2, all members of Link
Groups 1 and 2 will also be cross-linked. Waveform Views are cross-linked by using the Link
button at the top of Waveform View 2. (see Waveform Views 72 , Toolbar Buttons 79 )

4.10

Searches
When analyzing the captured data, the ability to search forward and backward for specific pattern
matches or packet values is indispensable. DigiView provides a general search type for pattern
matches, a Sequential Frame and sequential Field search for parsed signals and a Search
Manager to quickly perform multiple searches and change criteria. The following sections provide
details of DigiView's searching capabilities.

·
·
·
·
·
·

Defining Searches 91
Performing a Search 93
Using the Search Manager 93
Auto Search Windows 94
DigiView's Search Types 96
Searching Capture History (see Capture History

64

)

4.10.1 Define Searches
New searches are defined by clicking on the "Search->new" menu item and selecting the signal
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to search from the submenu. Depending on the type of signal selected, a Pattern Search or
Sequential Search will be created and its editor window will automatically open. For example, if
you have selected a signal of type "I2C", then the Sequential search type will be created. (For
details on each search type, see: Search Types 96 ).
After a search is created it will be available in the Search Manager 93 and all search selection
windows, including selection for Auto Search 94 windows and searching the Capture History 64
files.
All search types (and therefore all search editors) have the following common properties.

Search Name - Description
Use the Name field to describe the search. This descriptor will be displayed in the Search
Manager Windows and in the Global Search selection box.
From - Where to begin Searching
The 'search from' selection determines where the search starts from; the current center of
screen or the current marker location. Since the marker is placed at the center of the screen
after the first search match, these are often the same during consecutive searches. The main
difference occurs during the first search or between searches if you scroll the screen.
Set Marker - Mark the match point
The marker selection determines which marker is used to show the search match. You must
select one. Whenever the search matches, the selected marker is placed at the match point
and then centered in the searched window.

Delete Button - Deletes this search
Use the Delete button to dispose of the search and remove it from all search managers.
Close Button - Closes this search editor window
Use the Close button when you are finished making changes and want to close the editor for
this search.
Search Button - Performs this search
Use the Search button to test the settings you have just entered for this search. Right-Click to
search forward from the current time of the marker. Left-Click to search backward from the
current time of the marker. When you are satisfied with the search settings, you can close the
search and use any search button in the application to continue searching. (see: Searching 93 )
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4.10.2 Searching
Search Button
Left clicking on a search button searches back in time (previous match.) Right clicking on a
search button searches forward in time (next match.) See 'Define Searches' 91 for details on
creating searches.

Invoking Searches
There are several methods of invoking a search. Each presents a slightly different way of
selecting the search and the target window, but they all perform the search in the same
manner.
If the search is configured to search 'from center time', then the search starts from the center
time of the FOCUSED window (possibly the last match). Otherwise the search starts from the
search's marker position (possibly the last match). In either case, the marker is positioned at
the location of the search match and then the FOCUSED window is centered on the marker. If
the window is part of a link group, then the entire link group is centered as well (see: Link
Groups 90 ). The center time of the FOCUSED window does not change if the search fails.
Regardless of how the search is invoked, we actually always run the DEFAULT search on the
FOCUSED windowed. We simply CHANGE the DEFAULT search or the FOCUSED window
before running the search in some cases. This creates a very consistent environment where
you can jump from one search button to another without surprises. The last invoked search is
always the current DEFAULT search and the last searched window is always the currently
FOCUSED window (until you do something to change it), regardless of how the search was
initiated.

Global Search
Beside the search selection box and search edit button is a SEARCH button. This search
button performs the Active Search, using the currently FOCUSED window as described without
changing either.

Local Search
Each Data Table, List and Waveform window has a local search button. When you click on a
window's local search button, that window becomes the FOCUSED window and then the search
is applied to it as usual (using this newly FOCUSED window). Clicking on a local search button
is the same as clicking anywhere on a waveform or table to FOCUS it and then clicking on the
Global Search button.

Search Manger Searches
When you click on a search button in the search manager, the DEFAULT search is changed to
that button's search and then the search is performed as usual (using this new DEFAULT
search). This has the same results as selecting the button's search from the Default search
selection pull-down and then clicking on the Global Search button. (see: Search Manager 93 )

4.10.3 Search Manager Windows
The search manager window shows a list of all defined searches (see: Define Searches 91 ). It
also provides an easy method of executing or editing any of the searches. This is particularly
useful if you need to do a series of searches involving different search types.
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To create a search manager, select "New Search Manager" from the Window menu. Multiple
search managers can be created.

Search - Each entry in the list includes a Search button in the left column. Left-click or Right-click
on the Search button to perform that search as described in the 'Searching 93 ' section.
Edit Search - Each entry in the list includes an Edit button in the second column. Click on the Edit
button to edit the parameters of a defined search.
Set as the Active Search - Click on the search name itself or use either of its buttons in the
search manager and the search will automatically become the Active (or Global) search. Any
search button in the program will perform the Active search.
New - Click the New button to select a signal and create a new search.
Copy - When the copy button is clicked, a new search is created identical to the current search.
The new search is added to the Search Manager, renamed by adding a sequential number to the
search name, automatically selected as the Global Search and is opened for editing. This is a
very convenient feature if you want to add another search with similar criteria while retaining the
original search or you need similar criteria for more than one signal.
Delete - Deletes the selected search.

4.10.4 Auto Search Windows
Auto Searches expand the normal search to a linked list of positions in the captured data that
meet the search criteria. Click on any line of the resulting list to scroll the matching data into view.
Auto Searches also have the ability to halt the analyzer, determine which captures to preserve and
which captures to discard based on the search result.
Main Auto Search Features
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1. Automatically runs selected searches after each capture or capture history 64 load.
2. User settings allow for halting, saving or skip-saving the capture based on match counts.
3. Presents a list of matches and the count.
4. Clicking on a search match will bring the highlighted or focussed Waveform View to the time
marked by the search match. All other views within the same link group as the waveform view
will also update to the new time position.

Save, No Save and Halt Options - Click the Menu Button to set the Auto Search Options.
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Use Global Save Settings
Select this option to let the default save settings determine when to save the capture. When
selected, the Save Qualifier section is disabled. (see Acquisition Options 53 )
Save if Condition is True
Select this option to have the capture saved if the Save Qualifier equates to true. If the
Global setting is already set to "Save" then this selection will have no effect. (see Acquisition
Options 53 )
Do Not Save if condition is true
Select this option to mark the capture for "Discard" if the Save Qualifier equates to true. If
the Global setting is already set to "Do Not Save" then this selection will have no effect. (see
Acquisition Options 53 )
Halt Analyzer if Condition is True
Select this option to stop the analyzer from continuing to capture if the Halt Qualifier equates
to true.

4.10.5 Search Types
Searches are defined in terms of Signals matching specific criteria. Depending on the search
type, one or more signals are selected and a match pattern, match value or other conditions are
defined for each. All Boolean, Bus and Analog signals use the Pattern Search type and all other
signals (including those derived from Plug-ins), use the Sequential Search type.
Sequential searches allow a sequence of match conditions consisting of fields within frames
among a sequence of frames. Each field match can have a specific value or a "don't care" (Any)
value, and a specific skip count or a skip count of "Any". With the sequential search a very long
sequence, consisting of multiple wildcards (any Field, any Frame, any Field Value) and specific
frame or field skip counts and specific Fields and Field values, can be defined to locate the
proverbial "needle" in a very long "hay stack". Sequential searches also have the option of
placing the match marker at a specific point in the match sequence.
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Pattern searches match a pattern across multiple channels and multiple signals at a signal point
of time in the capture.
When ALL specified signals and conditions match the search criteria, the time of the match
condition (or Match Point) will be centered in the window that has "focus". Any other windows that
are a member of the same Link Group, will also center on the match point. (see: Searching 93 ,
Link Groups 90 )
Details of each search type below are explained in the following sections.
· Sequential Searches
· Pattern Searches 102

97

4.10.5.1 Sequential Searches
The Sequential search type is used by all Plug-ins or Parsed (decoded) signal types. This includes
all signals except the Boolean, Bus and Analog signal types (see: Define Searches 91 ).
This search type has a group of search terms (or criteria) that is specific to the chosen signal type,
and can perform a search sequence by adding additional terms. Terms can be added by using the
Copy or More buttons.
By changing the Mode (Field or Frame) to Fields, you can target the search to sequentially match
while ignoring frame boundaries. To look for a sequence of multiple frames, each having their own
field sequence match, select the Frame mode. If frame information is not present in the data, the
Mode will be limited to Field sequences.
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Field Mode

The number of Field terms is unlimited and each term is labeled using ASCII characters. In the
image above, three field terms are visible (a., b., and c. ). Using term 'a.' as an example, each
option is explained below.
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Push Pin button - This identifies which point in the sequence will be marked as the match
time in the search results. When selected, the 'Push Pin' will appear blue, indicating the
marker selected for the search will be placed at the beginning of this specific match term.
When de-selected, it will appear white, meaning another term in the sequence has been
selected for the marker position. If all terms have been de-selected, the first term in the
sequence will be selected automatically for the marker position.
Skip and Skip Count - Skip options are "Any number of fields" or "Specified number of
fields". When set to "Any number of Fields", the search will ignore the skip count and continue
searching for the next field that matches the criteria. The search will continue to the end of the
captured data if necessary before reporting a 'no match'. However, when set to "Specified
number of Fields", the search will only ignore (and skip) the number of fields specified in the
skip count editor before looking for the next match. If the next term after the skip count does
not match, then the search reports a 'no match'. Setting the skip count to a value of "0"
instructs the search to analyze the very next field in sequence (Do Not Skip).
Field - Some Signal types will have many field identifiers that can be used for targeted
searching. The Field selection can be used to choose the specific field type to search. If the
field to consider for the match is not the type specified, then the result is a 'no match', even if
the value for the field matches the specified value. The field selection options for the built-in
Async Signal type are shown below.

Value to Match - Depending on the specific field type, 1 or more values can be specified for
the match. Some fields do not have any additional values, so the search is a 'match' if the
specified field is found (i.e. Parity Error above). Other fields may have several values within
the field. Each value is referenced in the value editors with a preceding "%". As shown above,
the 'DATA' field has 1 value, identified by "%1". Below is an example of the editor for the
DATA field.

The value to search for can be specified in Decimal, HEX, Binary or ASCII format as
demonstrated below.
Decimal - 77
HEX
- 0x4D
Binary - b1001101
ASCII - 'M'
An example of a Field with more than 1 value (from the SPI signal type):
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Buttons - The three buttons on the bottom left of a field term are for deleting the current term
(-), adding a new term below the current one (+) or creating and adding a duplicate of the
current term (Copy).
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Frame Mode

Frame mode uses the same logic as field mode but adds an additional layer of grouping if frame
information is present in the data. The number of frame terms is not limited and each frame is
labeled numerically, starting with "1".
Skip and Skip Count - The Skip and Skip Count parameters apply to Frames (a group of
fields) instead of fields. The Field match sequence within each frame is limited to the fields
bounded by framing data of the signal type. We do not limit the number of Field terms or skips
within a frame. However, If you specify a sequence that involves a a greater number of fields
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than the number of fields available in the framed data, the search will fail.
Buttons - In frames, the Delete, Add and copy buttons are located at the upper right corner of
the frame term and have the same functions as those described for fields, but apply to the
frame. If you copy a frame, the new frame will be identical to the one copied, including all field
terms and their individual settings.

4.10.5.2 Pattern Searches
The Pattern search type is used for Boolean, Bus or Analog signal types (see: Define Searches
91 , Boolean Signals 11 , Bus Signals 12 , Analog Signals 16 ).

This search type can be used to find a value of one signal or a pattern of values in multiple
signals, that lasts for a specified time period.
You can see in the "Fetch from 094D" search displayed above, that it will search for a pattern
consisting of values from three signals (ALE, PSEN, AD14-0) that lasts for a duration of more than
50 nanoseconds. If this condition is found in the captured data, the specified marker will be set to
the time when the match occurs. In the above example, this would be 50ns after the matching
pattern begins.
Match Duration: Determines whether to skip all packets until a match is found, or to skip the
number of packets specified in "Skip Count" and then see if the next packet is a match.
Duration Units The duration qualifiers can be in ns,us,ms or sec and can use REAL numbers
(1.23 us).
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Signals: Select a signal from this list to "add" them to the search. Signals added to the search
are displayed below the signal selection box where the pattern to match can be edited.
Match Pattern Format The match patterns can be specified in decimal, hex or binary. To
indicate a HEX specification, precede the number with '0x'. To indicate BINARY, precede the
number with 'b'. Binary specifications allow '0','1' and 'X' (don't care) characters. HEX
specifications allow HEX digits (0-1,A-F) or 'X' for a nibble of don't care bits. Decimal
specifications must use only 0-9.
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Window Arrangement
DigiView makes extensive use of Docking and Tabbing to permit very flexible window arrangements.
All window settings, positions and sizes are saved along with the captured data anytime you save a
file or exit the program. These settings are all restored when you start the software or load an
existing '.DAT' file (see Saving and Restoring 129 ).
The main application is called the Primary window.
The windows created from the 'Windows' menu are called secondary windows.
· Docking Windows
· Tabbing Windows

5.1

105
106

Docking Windows
Dock Sites
The main application form has 6 docking sites; top,bottom, far top, far bottom, left and right.
Any of the secondary windows can be 'docked' to one of these sites by dragging the window
over the site. To prevent docking while dragging a window near a dock site, hold the Control key
down while dragging.
Docking a Window
When dragging a window over a docking site, a gray rectangle appears to indicate that the dock
site is willing to accept the window. Releasing the mouse button at this point docks the window
to the main form at this spot.
Multiple windows can be docked into each of the dock sites in a variety of positions. As you drag
additional windows over a given dock site, a different gray rectangle indicates where the window
would split into the dock site. You can drag it near the top, far top, bottom, far bottom, left or
right edges to control the placement.
If you drag the window inward a bit more, the rectangles change slightly to indicate a willingness
to split the space occupied by an existing docked window, rather than the dock site itself.
Dragging the window further towards the center of a docked window will cause the rectangle to
center in the window, which indicates the new window will "TAB" with the existing window (see:
Tabbing Windows 106 ). This flexibility allows you to dock the windows in virtually any
configuration.
Floating a window
To 'undock' a window, simply drag it off of the dock site by its title bar, double-click its title bar or
click on the down arrow in its upper right corner.
To 'untab' a window from a group of tabs, simply drag its tab away from the group and it will
become an independent window again.
Over-riding Docking
If you wish to drag a window near a dock site but do not want it to actually dock, hold down the
control key while dragging. This will disable the docking behavior, allowing you to drop the
window without docking it.
(also see: Tabbing Windows
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Tabbing Windows
Tabbing windows
Secondary windows can be merged together by dragging one window over another. When you
drag any secondary window over another secondary window, a centered rectangle line
appears.

This indicates that dropping the window at this point will merge them together into a single
window. Each original window appears on a TAB in the new window. Dropping additional
windows onto the tabbed window creates additional tabs.
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Tabbed windows can be docked just like any normal window. Also, a secondary window can be
tabbed with a secondary window that has already been docked. Simply drag the window over
the center of the docked window until you see the centered gray rectangle. This will TAB them
together at the docked location rather than dock the new window next to the existing window.
Floating a tabbed window
You float a tabbed window just like a normal secondary window; simply drag it off of the dock
site using its title bar, double-click its title bar or click on the down arrow in its upper right corner.
This will float the entire tabbed window, keeping all of its tabs intact.
De-Tabbing a window
To remove a window from a tab, simple grab the tab and drag it or double-click on the tab. This
extracts the window from the tabs and floats it. When only two windows are tabbed together and
one of these is removed, the tabbed window will be disposed of and the remaining window will
now occupy the position previously occupied by the tabbed window. If the tabbed window had
been docked, then the remaining window is now docked in its place. See Docking Windows 105
for more information on docking.
Tab Window Options
After "Tabbing" windows together, several display options are available from a pop-up menu
that is accessible by Right-Clicking on any of the Tabs. For details on these options, see Tab
Window Options 107 .
(also see: Docking Windows

5.2.1

105

, Tab Window Options

107

).

Tab Window Options
After "Tabbing" windows together, several display options are available from a pop-up menu that is
accessible by Right-Clicking on any of the Tabs. Available options depend on the selected Tab
Orientation.

© 2014 TechTools

108

DigiView User's Guide

Tab Orientation
Options are TOP, LEFT, BOTTOM, RIGHT. Choose one of these options to change the
placement of the Tabs in a tabbed window.
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Tab Rows
Options are SINGLE, MULTIPLE. Choose multiple to have the tabs align in a single row
with "scroll buttons" on the right. Choosing multiple will change the tabs to the default
multiple row behavior and remove the "scroll buttons". Tab orientation must be set to Top
or Bottom to select the Single option.
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Tab Size
Options are STRETCH to FIT, NORMAL. Choose "stretch to fit" to have the tabs "fill" the
available space when multiple rows are present. Select "normal" to size the tab to the
length of its text.
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Tab Style
Options are TABS, BUTTONS, FLAT BUTTONS. Tab orientation must be set to "TOP" to
select the option of Buttons or Flat Buttons.
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Exporting
The captured data can be exported to a file in ASCII format for further analysis or documenting
purposes. DigiView provides three export methods to choose from with each method having a few
unique features. These features are documented in the next three sections:
· Exporting All Signal Data (Raw) 114
· Exporting From List Windows 116
· Exporting From Table Windows 117
Properties common to all three export methods are discussed below.

Export To
At the top of each export dialog, the file name and path for the export file will be displayed. To
change the name or location, chose the button to the right of the filename. You can chose any
valid storage device for your system including a Network Drive, Floppy Disk, FLASH Memory,
and etc.

Time Range
Select the Starting time and Ending time of the data to export. You can select from several
predefined time points (i.e. Waveform View 1 Start, Trigger, Marker 3, etc) or select Custom to
manually enter the time.
Estimated Free Disk Space
The available space of the export destination is calculated and displayed here. The available
space will be calculated whenever the destination changes. While the export is in progress, this
will be updated to keep you informed of remaining space. If the available space becomes too
small for the remaining portion of the export, then the export will automatically finish without
exporting the rest of the data.
Required Disk Space
The amount of disk space required to hold the exported data will be displayed here. Since all
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storage devices require a minimum amount of space to hold a file, the minimum file size will be
shown if the exported data is smaller. If the export size is very large, the background color of this
display will turn to yellow. If the export size exceeds the available space on the storage device,
the background color will turn to red and the export prevented from being performed. The export
size will be calculated whenever any option or the destination changes.

Progress indicator
The lower left portion of the Export dialog will display the progress of the export. The progress
display will indicate the number of bytes already exported, the percentage of the data already
exported and the number of bytes per second being written to the storage device.
Abort Button
The export can be canceled at any time by selecting the Abort button. All data exported up to the
point of cancellation will be available in the exported file.
Close Button
To exit the Export window, choose this button. If an export is in progress, the export will be
canceled automatically.
Export Button
After selecting the desired export options, choose this button to begin the export. This button will
be disabled while an export is in progress or the export size is being calculated.

6.1

Exporting All Signal Data
This export method can be selected from the File menu (File->Export->UnDecoded Capture) and
provides a means of exporting the raw data of all defined signals. The available options let you
chose which signals to export, time format, numerical format, field separator, inclusion of line
numbers, inclusion of a timestamp and whether to use compression. (see: Exporting 113 )
The Exported Data Example area will be updated automatically to reflect any changes in export
options.
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Timestamp
If the "Include Time Stamp" option is selected, the time field will be formatted as the absolute
time or (if set to Delta) as the time since the previous sample (or the last known sample after
the starting time). If the "Data Compression" option is set to OFF and this option is set to Delta,
then the time field will show the sample rate.
Numerical Format
This option determines the formatting for each signal that uses more than one channel (Boolean
signals will always be formatted as a '1' or '0'). This option will display the format setting of a
signal when a signal is selected. To change the format for a signal, first select the signal in the
Signal Selection area. If changes are allowed for the selected signal, then the format options will
"enable". Select the desired option.
Field Separator
Chose the character for separating each item on a line of exported data.
Include Line Numbers
Select this option to include a consecutive line number at the beginning of each line.
Include Time Stamp
Select this option to include the time of each exported sample.
Signal Selection
Check each signal to include in the export. The order of export is determined by the order in
which each signal is checked. To have the export order match the listed order, use the Clear All
button to clear all selections, then use the Select All button to select all the signals in the order
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shown. To move a signal to the end of the export line, uncheck and then recheck the signal.
When a signal is highlighted with the mouse, its export format setting will be shown in the
Numerical Format option. This option can be changed by selecting the desired format (excluding
Boolean signals).
Data Compression
Setting this option to ON will greatly reduce the size of the export file. With compression on, the
redundant or "dead" periods of data will be excluded and only changes in the data will be
exported. If this option is set to OFF, then no data will be eliminated and all samples at the
maximum resolution will be exported. This could lead to very long exports with sizes up in the
Terabyte range.
Clear All Button
Use this button to "uncheck" all signals in the Signal Selection Area. Unchecked signals will be
excluded from the export.
Select All Button
Use this button to "check" all signals in the Signal Selection Area. All checked signals will be
included in the export.
Exported Data Example
This area provides an instant "preview" of the data to export and is updated when any option or
signal selection is changed.

6.2

Exporting from List Windows
This export method can be selected from the File menu (File->Export->Table/List) or directly from a
List Window's menu. List Exports export the decoded data of higher level signals (such as I2C), and
will have a slightly different set of options that are specific to each signal type. (see: Exporting 113 ,
Signal Types 8 , List View Windows 87 )
The Exported Data Example area will be updated automatically to reflect any changes in export
options.
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Numerical Format (Radix)
This option determines the formatting for each signal that uses more than one channel (Boolean
signals will always be formatted as a '1' or '0'). This option will display the format setting of the
signal in the list view being exported. To change the format for exporting, select the desired
option.
Field Separator
Chose the character for separating each item on a line of exported data.
Field Mode
Select this option to force each field to a new line when framing data is present. Uncheck this
option to output a frame of fields per line.
Include Line Numbers
Select this option to include the line number at the beginning of each line.
Include Time Stamp
Select this option to include the time of each exported sample.
Exported Data Example
This area provides an instant "preview" of the data to export and is updated when any option or
signal format is changed.

6.3

Exporting from Table Windows
This export method can be selected from the File menu (File->Export->Table/List) or directly from a
Table Window's menu. Table Exports provide all the same options as the "Export All" function, but
will automatically include all columns of the table. This means you will not have to select which
signals to export, plus all channels of any signals that are "expanded" will also be included in the
export. This is the only export method that will export expanded channels. (see: Exporting 113 ,
Export All 114 , Table Windows 84 )
Tables display and export signals in their "raw" data format. If you need to export the decoded data
of higher level signals (such as I2C), then the List Export should be used instead. (see: List Export
116 , I2C Signals 18 )
The Exported Data Example area will be updated automatically to reflect any changes in export
options.
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Timestamp
If the "Include Time Stamp" option is selected, the time field will be formatted as the absolute
time or (if set to Delta) as the time since the previous sample (or the last known sample after
the starting time). If the "Data Compression" option is set to OFF and this option is set to Delta,
then the time field will show the sample rate.
Numerical Format
This option determines the formatting for each signal that uses more than one channel (Boolean
signals will always be formatted as a '1' or '0'). This option will display the format setting of a
signal when a signal is selected. To change the format for a signal, first select the signal in the
Signal Selection area. If changes are allowed for the selected signal, then the format options will
"enable". Select the desired option.
Field Separator
Chose the character for separating each item on a line of exported data.
Include Line Numbers
Select this option to include a consecutive line number at the beginning of each line.
Include Time Stamp
Select this option to include the time of each exported sample.
Signal Selection
All Signals in the Table are automatically displayed in this area and "checked" for export. To
exclude a signal from the export, cancel the export, remove the signal from the Table, then
select export again. Optionally you could use the Export All function if you do not need to export
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the channels of "Expanded" signals. (see: Export All
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)

When a signal is highlighted with the mouse, its export format setting will be shown in the
Numerical Format option. This option can be changed by selecting the desired format (excluding
Boolean signals).
Data Compression
Setting this option to ON will greatly reduce the size of the export file. With compression on, the
redundant or "dead" periods of data will be excluded and only changes in the data will be
exported. If this option is set to OFF, then no data will be eliminated and all samples at the
maximum resolution will be exported. This could lead to very long exports with sizes up in the
Terabyte range.
Exported Data Example
This area provides an instant "preview" of the data to export and is updated when any option or
signal format is changed.
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Printing
While analyzing the data, you may want to save a specific view to a graphic file or send it to a
printer. Both of these functions can be done from DigiView's Print window. To open the Print
window, select a Table, List, Waveform view or the main view from DigiView's FILE menu. The
selected view will be presented in the Print window with the options set to JPEG by default. The view
to print can also be selected directly from a view's popup menu.
Details of the Print Window's options are described in the next two sections.

· Printing Options 122
· JPEG Options 125
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Printing Options
To send the view's image to a printer, select Printer as the Output Type. After selecting this output
type, the options in the Print Window will change for printing.

OutPut To
The currently selected printer name or print driver name will be displayed here.
Orientation
Select the orientation. This is the same setting that can be accessed from the Configure Print
Device options.
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Configure Print Device
Use this button to access all options of all available print devices.

Select a different printer by using the selection box in this window. Available printers can also be
selected in the selection box beside the Configure Print Device button if you do not need to
access the printers detailed properties. Select the Properties button to access detailed options of
the displayed printer.
Include Comments
Select this option to add comments to the Bottom of the image to be printed. When the Print
Window is opened, the capture data and time are automatically added to the comment section. If
you do not want to include the capture information, it can be deleted.
The comment box below the image to print will increase in size as you type comments. If the
comment needs more room, the size of the image will decrease. The preview in the upper
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portion of the window will automatically update as you change options or type comments.

Cancel Button
Use this button to close the print window without printing.
Print
Use this button to send the image to the printer.
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JPEG Options
To save the View's image as a JPEG file, select JPEG as the Output Type. After selecting this
output type, the options in the Print Window will change for JPEG images.

OutPut To
The currently selected image file name and path will be displayed here. Use the Select Save
Location button to change the name or path and preview images already saved.
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Select Save Location
Use this button to change the destination and save the image or preview images already saved.

To preview a saved image, select an image from the list, then use the button in the top right
corner of the window.
To exit this window without saving the image, choose the Cancel button.
Include Comments
Select this option to add comments to the Bottom of the image to save. When the Print Window
is opened, the capture data and time are automatically added to the comment section. If you do
not want to include the capture information, it can be deleted.
The comment box will increase in size as you type comments. Since the comment box is actually
part of the image to save, the size of the image will increase as the comment needs more room.
The preview in the upper portion of the window will automatically update as you change options
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or type comments.

Cancel Button
Use this button to close the print window without saving the image or if the image was already
saved when selecting the destination.
Save Image
Use this button to save the image to the selected destination.
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Creating, Saving and Restoring Project Files
Save Project File
The Save Project function is under the FILE menu. The current state (Zoom, time, marker
locations, waveforms associations, etc.), all windows, signal definitions, search definitions,
trigger definitions, and the data buffer of the current capture are saved to the file you select.
The data is always stored in compressed format, so the size of the project file will vary
from a few KBytes up to just over 4 MBytes.

Save As New Project
The Save As New Project function is located on the FILE menu. It performs the same function
as the normal "Save Project" option, but will prompt you for a new name and ask permission to
copy the capture history for the new project. The entire capture history for the current project will
automatically be copied for the new project if you select yes when prompted. The "Copy History"
prompt also displays the amount of disk space being used by the history files and will copy as
many files as free space allows, leaving a safety margin. The most recent captures are copied
first in case you do not have enough space available for the entire history to be copied to the
new location.

Open...
The Open (Restore) function is under the File menu (File->Open). This will load a previously
saved project file and verify its capture history.

Auto Save/Restore
The "Auto Save" and "Restore last File" options are found in the Environment settings 57 (found
under the CONFIG menu). When both of these options are enabled, DigiView auto-saves the
current data, settings and state of the project when you exit the program (or have requested a
different project to be loaded) and auto-loads the last opened project when you start the
program. This allows you to pick-up where you left-off the next time you start the software
without having to save/restore. You can still save the project manually anytime you need by
using the "Save Project As" selection on the File menu or clicking the "Save" button.

New Project
To start completely fresh and eliminate all defined signals, searches, data, triggers and
windows, select the New Project option from the File menu.
When creating a new project file, you must select the proper analyzer model and optionally the
preferred sampling mode. For this reason, the software will provide a selection window with
information regarding any detected hardware as shown below. Simply select the Model and the
Sampling Mode, then click on the "OK" button to create a new file. If you do not want to create a
new project, then select cancel to continue with the currently loaded project.
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Convert Project
If you want to use the same project configuration but convert it to be compatible with a different
model of analyzer, select the "Convert Project" option from the File menu. However, be aware
that Conversion will delete the current projects Capture History. If you have a capture history
that you want to preserve, the project should be saved with a new name before converting.
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· DigiView Compression 133
· Hardware Specifications 135

9.1

DigiView Compression
There is no need to understand DigiView's compression to use it. This is just here for the
curious (or skeptical).
We want two conflicting features in a logic analyzer; high sample RATES (high resolution) and
high sample COUNTs (a lot of data/time). We usually reduce sampling RATES to capture more
data because sample COUNTs (data buffer depth) is fixed. To combat this trade-off, the sample
buffer is made as deep as possible. However, this approach is linear and does not scale well.
Doubling the buffer doubles either TIME or sample RESOLUTION. It can take gigabytes of
memory to achieve both if your data transitions are fairly sparse (microsecond or more gaps).
Ideally, we would like to have high sample RATES AND high sample COUNTs to capture a long
time-span with high resolution.
DigiView achieves this, like other logic analyzers, by using a deep data buffer. However, DigiView
also attacks this problem from another, even more effective angle. DigiView uses one or more
real-time, hardware based compression techniques to compact the captured data. This has a
much greater impact than increasing the buffer depth.
Most data you are likely to monitor lends itself well to our compression technique(s). Compression
ratios of 100:1 are common. With sparse data, compression ratios of over 200,000:1 are
achievable. Since the degree of compression depends on the amount of activity, you will achieve
maximum compression if you only define signals of interest. DigiView analyzers will always
sample at the maximum rate for the mode selected. Due to automatic real-time compression
techniques, you receive the benefits that down-sampling would achieve (longer captures) without
the loss of data resolution.
The data captured in logic analyzer applications is often stable for multiple sample periods
(particularly at higher sample rates). This, coupled with fast sample times and a very long
run-length limit, makes our compression very applicable in real-world applications.
To illustrate the effect of DigiView's compression and also present it in a manner that is more
relevant to real-world usage, we have calculated several typical performance benchmarks for each
DigiView Model and sampling mode. You may actually see better performance ratings than the
conservative estimations below.
DV3109
Sample Depth
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( SR: Sample Rate,

DV3209

DR: Data Rate,

DV3409

DV3100

DV3200

Q: Quadrillion or 10^15 )

DV3400
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DV3109

DV3209

DV3100

DV3200

DV3400

Theoretical Min
(SR = DR)

512K x
9

512K x 9 1M x 9

512K x
18
512K x
9

512K x
18
1M x 9

512K x
36
1M x 18

Practical Min
(SR = 4 x DR)

1M x Channel width

@ DR = 25Mbps (40ns)

1M x 9

4M x 9

1M x 18
2M x 9

2M x 18
4M x 9

2M x 36
4M x 18

@ DR = 10Mbps (100ns)

2.5M x 9 5M x 9

10M x 9

2.5M x
18
5M x 9

5M x 18
10M x 9

5M x 36
10M x
18

@ DR = 100Kbps (10us)

250M x
9

1B x 9

250M x
18
500M x
9

500M x
18
1B x 9

500M x
36
1B x 18

@ DR = 10Kbps (100us)

2.5B x 9 5B x 9

10B x 9

2.5B x
18
5B x 9

5B x 18
10B x 9

5B x 36
10B x
18

Theoretical Max
(DR approaches 0)
(Quadrillion)

3Q @
10ns
(347
days)

6Q @
2.5ns
(173
days)

3Q @
10ns
(347
days)
3Q @
5ns
(173
days)

3Q @
5ns
6Q @
2.5ns
(173
days)

4.5Q @
5ns
9Q @
2.5ns
(260
days)

Typical Captures @ Full Resolution

2M x 9

500M x
9

3Q @
5ns
(173
days)

DV3409

( data type / count stored in hardware buffer )

0.1Hz clocks

87,000

131,000

1KHz clocks

87,000

131,000

5KHz clocks

131,000

25MHz clocks

131,000

Async characters

47,000

I²C characters

10,000

Sync characters

12,000

8051 Bus cycles

40,000

Final note: the data is compressed in real-time with dedicated hardware and is NEVER fully
de-compressed (which could result in data files much larger the available hard-drive capacities).
DigiView software transfers the entire compressed data buffer from the hardware to internal PC
memory in compressed form. This allows us to transfer the entire buffer in about 1 second. The
waveform display routines fetch only enough data from the compressed memory buffer to fill the
viewable portion of the display screen and even that is compressed.
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DigiView Hardware Specifications
DV310
9

DV320
9

DV340
9

DV310
0

DV320
0

DV340
0

Sample Rate
(Msps)

100

200

400

100 @
18 ch
200 @ 9
ch

200 @
18 ch
400 @ 9
ch

200 @
36 ch
400 @
18 ch

Sample period
(ns)

10

5

2.5

10 @ 18
ch
5@9
ch

5 @ 18
5 @ 36
ch
ch
2.5 @ 9 2.5 @ 18
ch
ch

Channels

9 (x 1)

9 (x 1)

9 (x 1)

9 (x 2)

9 (x 2)

Threshold Circuits

1

2

Adjustable Threshold

+0.5V to +2.8V

-6V to
+6V

Threshold Accuracy

+- 250mv

Trigger Output (BNC)

No

Trigger position

Selectable (0-100%)

Buffer Size

Selectable (0-100%)

Raw Memory

9 Mbit
(512K x 18)

Real-time Compression

Yes, Tri-mode (varies according to transition frequency, duration
of changes and duration of constant change)

Sample Depth

( SR: Sample Rate,

Yes

DR: Data Rate,

18 Mbit
(512K x
36)

Q: Quadrillion or 10^15 )

Theoretical Min
(SR = DR)

512K x 9 512K x 9 1M x 9

Practical Min
(SR = 4 x DR)

1M x Channel width

@ DR = 25Mbps (40ns)

1M x 9

2M x 9

@ DR = 10Mbps (100ns)

250M x
9

@ DR = 10Kbps (100us)
Theoretical Max
(DR approaches 0)
(Quadrillion)
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18 (x 2)

512K x
512K x
18
18
512K x 9 1M x 9

512K x
36
1M x 18

4M x 9

1M x 18
2M x 9

2M x 18
4M x 9

2M x 36
4M x 18

500M x
9

1B x 9

250M x
18
500M x
9

500M x
18
1B x 9

500M x
36
1B x 18

2.5B x 9

5B x 9

10B x 9

2.5B x 18 5B x 18
5B x 9
10B x 9

5B x 36
10B x 18

3Q @
10ns
(347

3Q @
5ns
(173

6Q @
2.5ns
(173

3Q @
10ns
(347

4.5Q @
5ns
9Q @

3Q @
5ns
6Q @
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DV310
9

DV320
9

DV340
9

DV310
0

DV320
0

DV340
0

days)

days)

days)

days)
3Q @
5ns
(173
days)

2.5ns
(173
days)

2.5ns
(260
days)

Typical Captures @ Full Resolution

( data type / count stored in hardware buffer )

0.1Hz clocks

87,000

131,000

1KHz clocks

87,000

131,000

5KHz clocks

131,000

25MHz clocks

131,000

Async characters

47,000

I²C characters

10,000

Sync characters

12,000

8051 Bus cycles

40,000

Trigger Circuitry
Operating speed (MHz)

100

200

200

100

200

200

Min Data Valid for
Pattern Match (ns)

10

5

5

10

5

5

Min Data Valid for
Edge Detection (ns)

10

5

5

10

5

5

Electrical
Impedance

>50KOhm // <10pf @ (0-3.3V)
@ (<0, >3.3V)

Power Source

USB

External

Power (Idle / Active)

<.5 Watt / < 2.5W

2.5 Watt
/<7
Watt

Maximum voltage
(Continuous, all channels)

+-20 Volts

+-50
Volts

Ground current Protection
(ground lead to +- voltage)

Yes, +-12 Volts

Anti-static protection

Yes

Connection Type, Speed

>5KOhm // <10pf

50KOhm
s // < 3pf

USB 2.0 @ 480 Mbps

Mechanical
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DV310
9

DV320
9

Size (LxWxH)

4.75" x 2.8" x .75"

Materials

Extruded Aluminum

DV340
9

DV310
0

DV320
0
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DV340
0
5.0" x
4.25" x
1.40"

Trigger Specifications
DV3109
Trigger
Sequencers

DV3209

DV3409

DV3100

DV3200

DV3400

Configurable:
1@16 stages, OR 4@4 stages, OR 2@8 stages,
OR 1@8 and 2@4 stages,
OR 1@12 and 1@4 stages

Trigger
Match
Circuits

8 Universal Match Circuits. Each Circuit can be configured for any of the following:
Edge Detect (Full Channel Width - OR: rising, falling, either)Patterns (Full Channel
Width - AND: 0, 1, X)Stable (Full Channel Width)> , >=, <, <=, <> (Full Channel
Width)

Match
Duration

Yes
- 1 per match circuit
- up to 1M samples each

Trigger Pass
Count
Trigger
Output
Sources
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Yes (up to 1 Million per Sequencer stage)
Seq 1, OR Seq 2, OR Seq 3, OR Seq4
OR (8 input sum-of-8 input products of all 8 match circuits)
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82
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-AA 82
Abort Button 113
Acquisition Options 5
Active Marker 75
Active Search 93
Add a new Signal 8
Add new Signal 8
Alt+C 82
Alt+F 82
Alt+H 82
Alt+S 82
Alt+W 82
Analog 10
Analog Signal 16
Analyzer Options 5, 49
Analyzer State 63
Appendicies 133
Arbitrary Snap 72
Arbitrary Snap to center 72
Armed 63
Associated Channels 8
Asynchronous 10
Asynchronous Signal 14
Authenticode 2
Auto Run 61
Auto Save/Restore 57, 129
Auto Search 53, 94
Auto-Snap 75
Auto-Snap & Bring to Center 75

-BBandwidth shortage 68
baud rate 14
Bird’s-Eye View 72, 81
Bookmark 64
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Index

Boolean 10
Boolean Signal 11
Bring to Center 72, 75
Buffer Size 49
Buffer Usage 63
Bus 8, 10
Bus Signal 12
Bus Signal Format 72
bus-powered 5
bus-powered hub 2
BUTTONS 107

-CC 82
Cancel Button 125
capture buffer 63, 64
Capture History Options 53
Capture History Search 64
Capturing Data 61
CDROM 2
Center Line 57
Changing the Signal Color 8
Changing the Signal order 8
Channel Monitor 49
Channel Selection 11, 12, 14, 16, 18, 21, 23
circular queue 61
Clear 72
Clear All Button 114
clear the buffer 63
Click and drag to marquee 79
CLK 21, 23
Clock (SCL) 18
Clock Channel 25
Clock Edge 21, 23
Close Button 113
Collapse 72
Color Selection 25
Color Selection & Examples 11, 12, 14, 16, 18, 21,
23
Color Themes 5, 55
color-coded 6
common ground 8
communication errors 5
Communication Settings 14, 23
compression 114
CONFIG 6, 8
Configuration options 5
© 2014 TechTools

Configure Print Device 122
connecting 6
Connecting Data Lines 5
Connecting the Data Lines 6
connectors 6
Convert Project 129
create a new signal 8
cross-linked 90
Ctrl+Drag 82
Cursor 75
Cursors 75
Custom Baud 14
Custom Color Themes 55

-DData 21, 23
Data (SDA) 18
Data Compression 114, 117
Data Lines 6
Debug Plug-ins 57
Decode 18
Define Searches 91
Defining Signals and Triggers 5, 7
defining trigger conditions 5
Delete History 53
Delete Signal 8
Deleting Signals 8
DELTA mode 84
DESTINATION DIRECTORY 2
De-Tabbing a window 106
Disable Signal Channels 14
Display Behavior 53
Display Signals as a BUS 8
Do Not Change Position 53
Do Not Save capture History 53
Dock Sites 105
Docking a Window 105
Docking Windows 105
down-sampling 84
Drag & drop 72
Drag to place 75
dragging a marker 75
Drop & Bring to Center 75
Drop Marker 72
Duration Units 91, 102
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-EEarly Trigger 49
Edge Match 33
Edge Snap 72
Edge Snap to center 72
EDGE trigger 27
Edit Search 93
Edit Signal 72
Edit Signal Properties 8, 72, 84, 87
EITHER EDGE 27
Enable 21, 23
Enable Signal Channels 11, 12, 14, 16, 18, 21, 23
Enable State 21, 23
Enabled Status 8
Enforce Prefill 49
Environment options 5, 57
Equal Match 35
Estimated Free Disk Space 113
EXAMPLE #1 133
EXAMPLE #2 133
Expand 72
Expand order 72, 84
expanded channels 117
Export 84, 87
Export All 117
Export Button 113
export expanded channels 117
export methods 113
Export To 113
Exported Data Example 114, 116, 117
Exporting 113
Exporting All Signal Data 114
Exporting from List Windows 116
Exporting from Table Windows 117
external power supply 5

-FFALLING EDGE 27
Field Idle Timeout 23, 25
Field Length 23, 25
Field Mode 97
Field Separator 114, 116, 117
Field SYNC 23
Field/Frame modes 82

FLAT BUTTONS 107
Floating a tabbed window 106
Floating a window 105
Frame Idle Timeout 14, 21, 23, 25
Frame Length 14, 23, 25
Frame Mode 97
Frame on 9bit Address flag 14
Frame on SS 25
Frame SYNC 21, 23
Frame SYNC Channel 21
Free Run/No trigger 27
Free Scroll 72
Full Buffer 63

-GGlitch Filter 14
Global Search 91, 93
Goto 79
Goto M1+M2 79
Goto M3+M4 79
Goto M5+M6 79
GOTO marker 75, 82
Goto Trigger 79
Graphical Configuration 28
Greater Than Match 39
Greater Than or Equal Match
ground 6
ground wires 8

42

-HH 82
Halt 61
Halt Analyzer 94
Halt Options 94
Halt Qualifier 94
Halt when limitation reached 53
Halted 63
HALTING 61
hardware based compression 133
Hardware Status 63
high resolution 133
History Browsing 64
history buffer 64
History Menu 64
History Monitor 53
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History Searching 64
Horizontal Lines 57
Hot-Keys 72, 82

-II 82
I2C 10
I2C Signal 18, 87
IDLE 63
Include Comments 122, 125
Include I/O Direction 116
Include Line Numbers 114, 117
Include Packet Type 116
Include Status 116
Include Time Stamp 114, 116, 117
independent scrolling 79
Installing 2
Installing the Software 2
Installing the USB Drivers 2
Insufficient power 68
Invert CLK/Data 21, 23
Invert SDA/CLK 18
Invert Signal Value 11, 12, 14, 16
Inverted Signal Display 8
Invoking Searches 93

-JJPEG 121, 125
JPEG Options 125
Jump 72
Jump to Marker 75
Jump to markers 87

-LLess Than Match 43
Less Than or Equal Match 46
LEVEL then EDGE trigger 27
LEVEL trigger 27
Limit by Disk Free 53
Limit by Number 53
Limit by Size 53
line numbers 114
Link 72
Link / Unlink Waveform Views 79
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Link Group 84
Link Group indicators 90
Link groups 72, 90
Linking Views into Time-Relative Groups
List Exports 116
List View Windows 87
Local Search 93
LSB first 23
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-MMark the match point 91
Marker Selection 55
Marker Tack 75
marker visibility 55
Markers 75
Marque to Zoom 72
Marquee Zoom 72, 79
Match 97
match circuits 31
Match Duration 102
Match Pattern Format 91, 102
Match Point 96
match sequence 96
Match Type 31
Match Types 31
Maximum Disk Size for Capture History
Maximum Number of Captures to keep
Measurement Window 75
measurements 75
micro-grabber hooks 6
Minimum Disk Size 53
Minimum Post-Trigger Buffer 49
MISO Channel 25
Monitor signals 61
MOSI Channel 25
MSB First 14
Multi-channel signals 84
multiple channels 12

-NNavigating and Analyzing the Data 72
Navigation, Markers & Buttons 72
New 129
New List 87
new position 8

53
53
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New Project 129
New Search Manager 93
New Table 84
Next View 79
Noise Filter 18
Not Equal Match 38
Notify when Save Needed 57
Numerical Format 114, 116, 117

pre-filling 61
preview 61, 114
preview a saved image 125
Previous View 79
Print 72, 84, 87, 122
Print window 121
Printing 121
Printing Options 122
Progress indicator 113
Project Settings 8

-OO 82
Open 129
Orientation 122
OutPut To 122, 125
Over-riding Docking 105
Overwrite when limitation reached

-PP 82
packet values 91
Page 72
Parity 14
Parity/9bit Address flag 14
Partial(P) Fields 25
PAT 63
PATTERN 27
Pattern Match 32
pattern matches 91
Pattern Searches 96, 102
PFX 63
PH 63
physical channels 5, 8
physical layout of the cable 6
physical logic channels 10
PINOUT 6
Play Event Sounds 57
Play Trigger Sound 57
Plug-ins 57
Post Filling 63
Post-Filling 63
Post-Trigger Buffer 49
Power LED 68
Powered 63
POWERED HUB 2, 5
Pre Filling 63

-Qqualified trigger 27
Qualifier 21
Quick Select Flags 75
53

-RR 82
real-time hardware based compression 133
Reference Line for @ 57
Re-Frame on BREAK 14
rename the signal 8
Required Disk Space 113
Reset Colors 11, 12, 14, 16, 18, 21, 23
Reset Custom to Theme 55
Reset Row Height 57
Reset Row Heights 57
Reset Signal Colors 55
resistor color-code order 6
resolution 84
Restore Last File on Startup 57
RISING EDGE 27
Run 61

-SS 82
Sample Mode 49
sample rate 84
sampling mode 129
Save As 129
Save as JPEG 72, 84, 87
Save As New Project 129
Save capture History 53
Save Image 125
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Save Project File 129
Save Qualifier 94
Save, No Save and Halt Options 94
Saving and Restoring 129
SCL 18
Scroll 72
Scroll by 1 79
Scroll by 5 79
Scroll Start/End 79
Scroll To 79
Scroll to Marker 53
Scroll to Trigger 53
SDA 18
Search 79
Search Button 93
Search Description 91
Search Edit 79
Search History 64
Search Manager 91, 93
Search Manager Windows 93
Search Manger Searches 93
Search Marker 91
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